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Thank you for purchasing an EnvisuTM Spectral Domain Ophthalmic Imaging system. In 

developing our systems, we have placed great emphasis on simple, self-explanatory operation. 

This user manual contains important information related to the device, safety, operation, and 

cleaning. In order to avoid injury to persons or damage to the system this user manual, including 

indications, warnings and precautions, must be read and understood before performing any 

procedure. 

 

Thank you for choosing our products. We hope that you will enjoy the quality and performance 

of your EnvisuTM SDOIS system. 

 

For inquiries regarding sales, service, or support contact Leica Microsystems by either visiting 
 

http://www.leica-microsystems.com/service/ 
or by calling the One Call support number closest to your facility:  

Australia: 1 800 625 286 (Option 2)  

Austria: +43 1 486 80 50 27  

Belgium: +32 2 790 98 50  

China: +86 400 650 6632  

Denmark: +45 44 54 01 01  

France: +33 156 052 326  

Germany: +49 64 41 29 44 44  

Hong Kong: +852 800-969-849  

India: 1800 313 2339 

Italia: +39 02 57486.1  

Japan: +81 3 3761 1147  

Korea: +82 80 440 4401  

Netherlands: +31 70 413 2100  

New Zealand: 0800 400 589 (Option 2)  

United Kingdom: +44 845 604 9095  

United States: 1-800-526-0355 (Option 1, then Option 1)  

Portugal: +351 21 388 91 12 
 

 



For issues concerning the Leica manufacturing center please contact: 

 
Leica Microsystems NC, Inc. 

4222 Emperor Boulevard  

Suite 390 

Durham, NC 27703 USA  

Phone:  +1 919 314 5500  

Fax:  +1 919 314 5501 

 

CAUTION 

 

Federal law restricts this device to sale by or on the order of a physician or practitioner. 

 

      

Leica Microsystems CMS GmbH 

Ernst-Leitz-Strasse 17-37 

35578 Wetzlar 

Germany 

 

Legal disclaimer 

All specifications are subject to change without notice. The information provided by this 

manual is directly related to the operation of the equipment. Medical decision remains the 

responsibility of the clinician. Leica Microsystems has made every effort to provide a complete 

and clear user manual highlighting the key areas of product use. Should additional information 

regarding the use of the product be required, please contact your local Leica representative. 

You should never use a medical product of Leica Microsystems without the full understanding 

of the use and the performance of the product. 

 

Liability 

For our liability, please see our standard sales terms and conditions. Nothing in this disclaimer 

will limit any of our liabilities in any way that is not permitted under applicable law or exclude 

any of our liabilities that may not be excluded under applicable law. 
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Product Information 

Symbol Key 

The following symbols are displayed throughout the User Manual. 

 

Warning 
Warnings alert about situations that, if not avoided, could result in death or 
serious injury. 

 

 

   Warning 

Dangerous Voltage 
 

 

Note 
Notes identify technical requirements to which the user should devote 
special attention, such as remarks on common errors, unusual situations, 
and tips for optimized use. 

 

Alternating Current Symbol: Found on Electrical Safety Label on the back of 
the Engine and Interface Boxes 

 

Operating Instructions:  Found on Manufacturer Label Consult User Manual  

 

Protective Ground Earth:  Found inside Engine and Interface Boxes 

Intended Use  

Leica EnvisuTM Spectral Domain Ophthalmic Imaging system is intended to acquire, process, 
display and save depth-resolved images of ocular tissue microstructure using Spectral Domain 
Optical Coherence Tomography (SD-OCT). The EnvisuTM SDOIS is indicated for use as an aid 
in the diagnosis of physiologic and pathologic conditions of the eye through non-contact optical 
imaging. Imaging of the various tissues of the eye is supported through the use of 
interchangeable lenses. It is indicated for use on patient populations from premature and 
neonatal infants to adult, and is suitable for patients ambulatory or confined. The system is 
indicated for use in upright or supine imaging, handheld or mounted, and is suited for imaging 
patients under anesthesia.   
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IMPORTANT!  Read and understand the entire user’s manual before 

operating this system. If you have any questions concerning 
the use of this system, contact customer service. 

 

Users of this system should be physicians or technicians with professional training or 
experience in the use of retinal imaging equipment.  

 

Software Architecture and Terminology 

Leica’s InVivoVue 2.4 software is written in C++ for the Windows platform, and employs a 
database to manage patient and exam information.  The data collected for a patient during a 
visit or scan session is referred to as an exam, which has an associated physician (or P.I.), 
examiner, study, and treatment arm. In addition, exams may be defined to follow specific scan 
protocols.  Some of the terms used in this manual are defined below: 

Study:  This may be used to organize research done toward a funded grant, or as a way of 
organizing exam protocols to be followed on animal studies.   

Site ID:  A unique number assigned to each database instance.   

Treatment Arm:  In a randomized trial, this denotes any of the treatment groups. Treatment 
Arm can be used as a category or other means to differentiate patients within a study. 

Scan Protocol:  A standard group of scans that will be used on every subject in the study 

Patient:  This may indicate an animal subject or specimen being imaged. 

Medical Record Number (MRN):  The unique ID by which the patient may be identified at the 
institution. 

(Patient) ID:  The code name or number by which the subject is tracked within the research 
study. 

Exam:  This denotes a site visit or imaging session, and is a collection of one or more scans 
taken for one patient, on one day. 

Physician:  The primary physician or Principal Investigator at the site. 

Examiner:  The photographer or researcher who does the imaging. 
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Overview 

Introduction to the InVivoVue User Interface 

Leica’s InVivoVue software enables a user to acquire, process and display images acquired on 
the Leica spectral domain OCT system.  The program allows scans to be organized by research 
study, by animal subjects, by examiner and physician, and by exam or visit or scan session.  
This information containing the links between this information and the files in which actual image 
data is stored in a database. 

Software Layout 

The software user interface has four tabs (Study, Patient/Exam, Imaging, Reports) that are 
organized to reflect common workflows. 

The Study tab is used to enter the names of studies for which data is being collected. 
Organizing data into studies may be helpful in finding related data sets by filtering on the name 
of the study. It is typically visited on the day of software installation, and thereafter only when a 
new study is begun. However, on reader systems, users visit this tab to changes sites to review 
data that has been imported. 

The Patient / Exam tab is where new patient information is entered, and where a new exam 
may be defined.  Adding a new patient causes that person to appear in the master patient list.  
Selecting a patient from that list shows his personal details, as well as the exams that have 
been conducted for him.  A new exam may be started for the selected patient, and details like 
the physician, examiner, and study are associated with exams on this tab. 

The Imaging tab is where data acquisition and data review is performed.  It contains controls 
for defining and adding new scans for an ongoing exam.  It also controls that allow the user to 
playback image data. 

Finally, the Reports tab allows reports to be created for acquired data. 

The main menu consists of four sub-menus.  The File menu contains items for saving data in 
various formats, and for printing images.  The Tools menu has options for managing data files 
by importing/exporting and archiving/retrieving.  There are also options for creating and loading 
custom configuration files.  Advanced users may see options for interacting with the hardware at 
a low level.  The Reports menu contains roughly the same options as the Reports tab, for 
configuring and creating reports.  The Help menu has shortcuts for reviewing the user manual 
and release notes, as well as viewing dialogs with system and installation information. 
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User Interface 

Study Information 

 The main list (1) on the Study tab shows all the studies that have been defined.  The 
details for the one study selected from this list appear in the boxes to its right, at 2, 3, and 4.  A 
new study may be added by clicking the Add Study button (5).  These details may be modified 
later by clicking the Edit Study button (6).  An unused study is removed by clicking the Delete 
Study button (7), although the program will not allow the user to delete a study if there is an 
exam with data associated with that study. 

 

Figure 1: Study Tab 

If the list of studies is extremely long, it may be helpful to search for that study by typing 
either its ID (8) or Name (9) in the text boxes provided: the exam selected in the list will change 
to match what is typed. 

Data that has been acquired from other sites may be viewed on reader systems by 
importing that data.  However, only one site’s data may be viewed at a time.  By default, the 
program lists data only for the native site; however, if data has been imported, the user may 
choose to view a different site by clicking the Switch Sites button (10).  This button will not be 
visible unless some data has been imported. 

10 
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Adding a Study 

InVivoVue requires all exams to be associated with a study, which means that at least one 
study has to be defined before acquiring data.  However, users who choose not to group their 
data into studies may define a placeholder study, named for their site; thereafter, new exams 
will be automatically associated with that study, and the user can otherwise ignore this feature. 

However, research sites and users who wish to organize their data into groups may define 
an arbitrary number of studies, and filter exams by study and category. 

To define a new study, click the Add Study button, which brings up the study editor. 

 

Figure 2: Study Editor  

 The Study Name text box (1) contains the study’s identification, which must be unique 
at a given site, and is limited to 40 alphanumeric characters.  The Study ID (2) is also a unique 
string, limited to 20 alphanumeric characters.  Since the name and ID fields are what is listed in 
the main study list, it makes sense for users who plan to define multiple studies to give careful 
thought to providing mnemonic identifiers. 

 The Study Description (3) appears on the Study tab, but only when the study is 
selected there.  It is limited to 2000 characters, including everything but single-quote marks.  It is 
provided so that users can communicate intended use between users at an acquisition site. 
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 A scan protocol is a list of scans, of a particular pattern, with given physical dimensions 
and data density, to be executed in a particular order.  It is often useful to define a set of scans 
that will be collected for many patients as a protocol, so that new exams may be quickly populated 
with that list.  If any scan protocols are defined, they will appear in the Available scan protocols 
list (11) on the left hand side of the study editor.  Only protocols that are associated with a study 
will be available for selection when a new exam in that study is defined.  The protocols associated 
with a study appear in the Scan protocols in study list (12) on the right hand side of the study 
editor. 

 To add an available protocol to a study, click the Add >> button (13); the selected 
protocol will disappear from the left and appear on the right.  There is no limit to the number of 
protocols in a study, nor is there any particular penalty for adding a protocol, other than making 
the selection list longer. To remove a protocol from a study, click the << Remove button (14), and 
the selected protocol will disappear from the right and appear on the left.  There is no penalty for 
removing a protocol from a study, other than it not being available for selection. 

 The Save Changes button (15) is initially disabled, but will become enabled when a 
valid study definition has been entered.  Both the Study Name and Study ID text fields must 
contain unique text of legal length for the definition to be considered valid. 

 Clicking the Cancel button (16) will immediately close the study editor, discarding any 
changes that may have be made since the dialog was opened. 
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Editing a Study 

The details associated with already-defined studies may by modified by clicking the Edit 
Study button.  Doing so invokes the same study editor, with a few minor differences.  First, of 
course, the dialog will appear with all the fields filled in for the study being edited. 

All fields may be changed; even the study name and ID may be changed, although of 
course, existing reports will still reflect the old information. 

The UI controls for adding a treatment arm to a study are enabled for an existing study.  
A treatment arm may be considered simply a category of data, useful for organizing or filtering 
exams; a treatment arm may also correspond directly to a clinical treatment. 

 

Figure 3: Adding a treatment arm to a study  

In Figure 4, the Treatment Arm controls are disabled for studies being defined; they 
are only enabled when editing existing studies. Available Treatment Arms (4) may be added 
to the current study when pressing Add >> (5). << Remove (6) removes the selected 
treatment arm from the Treatment arms in study list (7). The arm is removed from the list on 
the right, and re-added to the list on the left.  (The Uncategorized treatment arm cannot be 
removed.)  In an existing study, you can name (8) and describe (9) treatment arms to be 
added to the study using the Create Treatment Arm (10) button.  
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Deleting a Study 

To completely remove a study definition, click the Delete Study button.  A study that has 
exams associated with it cannot be deleted.  To do this, either the exams have to be associated 
with a different study by selecting each exam, clicking Edit Exam, and choosing a different 
study in the exam editor. Alternatively, if no data was ever acquired for that exam, the exam 
itself may be deleted by clicking Delete Exam.  Depending on the state of the exam, the 
program may be able to do this entirely automatically, or may require that the abandoned scans 
in that exam be deleted first, before the exam itself is deleted.  
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Patient Information 

 The main list (1) on the Patient / Exam tab shows all the patients whose information has 
been entered in the database.  The list of exams conducted on this patient appears in the list on 
the right (2). Other details for the selected patient appear in the boxes below the exam list, in 
the group labeled View Patient Details (3). 

A new patient may be added by clicking the Add Patient button (4).  These details may 
be modified later by clicking the Edit Patient button (5).  An unused patient record may be 
removed by clicking the Delete Patient button (6), although the program will not allow the user 
to delete a patient if there is an exam with data for that patient. 

 

Figure 4: Patient / Exam Tab  
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Adding a Patient 

When a new patient arrives for an examination, a record of that patient’s information may be 
created, so that scan data collected can be automatically. To enter information for a new patient: 

1. Navigate to the Patient/Exam tab. 

2. Click the Add Patient button that appears below the patient list, near the bottom of the 
screen, and the Add Patient dialog box opens. 

 

Figure 5: Add Patient dialog box 

3. Enter an ID, First and Last names, the MRN (medical record number), and the DOB 
(date of birth), and select M or F for the patient's gender.  

 

Note 
InVivoVue will not let the patient record to be saved until a gender has been 
selected, and values entered for the ID and both name fields.  The ID and MRN 
values must be unique: if another patient with the same ID or MRN exists, 
InVivoVue will display an error icon, and the Save & Exit button will not be 
enabled.  The MRN field is optional, but if one Is entered, it must be unique. 

In addition, if another patient with the same combination of First and Last name is 
present, InVivoVue will display a warning icon.  A patient with a duplicate name 
may, however, be saved. 

The ID field may not contain anything but letters and digits.  The ID is used to 
prefix the names of data files collected this patient. Because the ID is going to be 
used as part of a file name, it is restricted to alphanumeric characters. 

4. If you know the values for Refractive Error and Axial Length for this patient's eyes, 
you can also enter them now; otherwise, leave the default values. 
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5. Notes may be added, both while the record is being created and later. Any Notes will 
be displayed on the Patient/Exam tab when that patient is selected. 

6. When you finish entering the information, click the Save & Exit button to save the new 
record and close the dialog box. 

When you have created the record, you can see the patient information in the View Patient 
Details group box at the bottom right of the Patient/Exam tab. 

 

The Anonymous Patient 

Occasionally, there is not enough time to enter new patient information before conducting an 
examination.  If an exam is started before creating a new patient or selecting an existing patient 
from the list, it is automatically associated with the anonymous patient.  The anonymous patient 
is a placeholder for data for which InVivoVue has no identifying information.  It can be treated 
the same as all other patients: exams can be run, scans acquired, and reports created…but 
there will be no information identifying the actual subject.  And while this is intended as a 
convenience for users pressed for time before an unscheduled examination, Leica does not 
recommend undue delay in entering clinical information. 

The anonymous patient always appears first in the patient list.  Its ID field contains the text 
Anonymous. 

 

Figure 6: Anonymous Patient 

Eventually it will be useful to enter the details for an anonymous patient, or to identify him by 
selecting an existing patient.  This action may be taken at any time: before, during, or after an 
exam, in one session or the next, on the date of the exam or later.  The steps on how to de-
anonymize a patient are given in the section on daily workflow concerning identifying 
anonymous patients. 

 

Note 
When assigning an anonymous patient to an existing patient, the user will be 
prompted to confirm that the selected existing patient is correct. 

 

Editing a Patient 

From time to time, you will need to update records, to include information from recent exams or 
to add notes to the files. Follow these steps to update records: 

1. Select the Patient/Exam tab (Figure 4). 

2. Find and select the patient record you want to change.  If the anonymous patient is 
selected, the information entered will be used to create a new patient record, and the 
current exam will no longer be associated with the anonymous patient, but with the new 
patient. 
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3. At the bottom of the tab, click the Edit Patient button, and the Edit Patient dialog box 
opens (Figure 8). 

 

Figure 7: Add, Edit, and Delete patient buttons. 

4. Enter new information and update existing information as needed for the record.  

5. When you finish updating the information, click the Save & Exit button to save the new 
record and close the dialog box. 

When you have updated the record, you can see your changes in the View Patient Details 
group box, at the bottom right of the Patient/Exam tab. 

 

Figure 8: Edit Patient dialog box 

 

Deleting a Patient Record 

You can delete a patient record if no exams are present. If exams are present but contain no 
data, you can delete the exams in order to delete the patient record. Follow these steps to delete 
records: 

1. Select the Patient/Exam tab. 

2. Find and select the patient record you want to delete. 

3. At the bottom of the tab, click the Delete Patient button (Figure 4), and the Confirm 
Delete message box opens. 
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4. If you are sure you want to delete the patient record, click the Yes button, and the record 
is deleted from the database. 

Finding a Patient 

If the database holds information for a long list of patents, it can be difficult to find a specific 
one. InVivoVue allows one to filter and sort the patient list in several ways, to help you find 
specific patients. Begin by navigating to the Patient/Exam tab. 

• To search for a specific record, enter identifying information in any field in the Find 
Patient group box. As you enter the patient’s ID, MRN, First or Last name, InVivoVue 
selects the first record that matches your entry. The more detailed your entry, the more 
precise is the match. 

 

Figure 9: Find Patient group box 

For example, if you type Smith in the Last name field, InVivoVue will find the first patient 
whose last name begins with Smith: Annie Smith will be selected. Only after the next 
character is entered, so that Smithf is in the Last name box, does InVivoVue skip past 
Annie Smith and select Robert Smithfield.  All four of the search boxes show work in the 
same way. 

• To filter which patients are shown, check one or more of the filter check boxes. For 
example, to only show patients whose exams belong to a particular study, check the 
Filter by study box, and select the study for which you want to find records: only patients 
with exams associated with the selected study will be displayed in the list. Or, to display 
only patients that have had an exam during a given month, check the Filter by exam 
date box and select appropriate From and To dates: only patients who took an exam 
during the specified date range will be shown. 
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Figure 10: Filtering and selecting patients in the List Patients group box 

 

• Multiple filters may be combined: to look for patients examined by a specific examiner 
as part of a given study, check both the Filter by study and Filter by examiner boxes 
and make the appropriate selections. Only patients matching both criteria will be listed. 

• If the display is being filtered and you wish to see the full list of patients again, just click 
the Display All Patients button.  All checked filter boxes will be unchecked, and the full 
list shown again.  Note that this button is only shown while the list is being filtered. 

• To sort the list of patients, click on any of the column headings to sort the list by the 
values in that column (Figure 10). Click on the column heading again to toggle between 
ascending and descending order.  Sorting the list will not affect which patients are 
shown, just in which order; in other words, if the list is being filtered, it will stay filtered 
after sorting. 

Physician and Examiner Information 

Creating a Physician Record 

Physician records are associated with exams, and one is selected each time you create a new 
exam. If the physician record you want is not in the system, you can create the record at the 
same time you add an exam to a patient's record. You can also create a physician record apart 
from any exam, as an administrative function; for example, if a new physician is joining your 
clinic or practice, you can add the record so that it is available when you are ready to conduct 
exams for his or her patients. 

Follow these steps to create a physician record: 

1. From the Tools menu, select Setup Examiners & Physicians..., or from the 
Patient/Exam tab, click the Setup Examiners & Physicians button. The Setup 
Examiners & Physicians dialog box opens. 
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Figure 11: Tools menu with Setup and Examiners & Physicians... 

 

 

Figure 12: Setup Examiners & Physicians button on right side of Set Exam Defaults/Add Exam 
box 

2. In the Select Physician group box at the bottom of the dialog box, select <NEW 
PHYSICIAN>. 

3. Enter the First Name and Last Name of the physician for the new record. (The 
combination of the First Name and Last Name must be unique in your system.) 

4. Click the Create New Physician button. 

5. If you need to create another physician record, repeat the preceding steps; otherwise, 
click the OK button to close the dialog box, and the new record is available to select for 
new exams. 

 

Figure 13: New physician created 
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Editing a Physician Record 

You can edit a physician record regardless of whether it is associated with any exams. You 
might want to edit the record if the physician changes his or her name. 

Follow these steps to edit a physician record: 

1. From the Tools menu, select Setup Examiners & Physicians..., or from the 
Patient/Exam tab, click the Setup Examiners & Physicians button. The Setup 
Examiners & Physicians dialog box opens. 

2. In the Select Physician group box at the bottom of the dialog box, select the name of 
the physician whose record you want to change. 

 

Figure 14: Editing a previously created physician 

3. Change the First Name and Last Name of the physician as necessary for the record. 
(The combination of the First Name and Last Name must be unique in your system.) 

4. Click the Save Changes button. 

5. If you need to change another physician record, repeat the preceding steps; otherwise, 
click the OK button to close the dialog box. The changes are reflected on all existing 
exams, and the updated record is available to select for new exams. 

 

Deleting a Physician 

You can delete physician records from the database provided that no exams are associated 
with that physician. InVivoVue warns against and prevents you from deleting a physician record 
with associated exams. 

Follow these steps to delete a physician record: 

1. From the Tools menu, select Setup Examiners & Physicians..., or from the 
Patient/Exam tab, click the Setup Examiners & Physicians button. The Setup 
Examiners & Physicians dialog box opens. 

2. In the Select Physician group box at the bottom of the dialog box, select the name of 
the physician whose record you want to delete. 

3. Click the Delete Physician button (Figure 14). 

4. If you need to delete another physician record, repeat the preceding steps; otherwise, 
click the OK button to close the dialog box, and the old record is no longer available to 
select for exams. 
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Creating an Examiner Record 

Examiner records are associated with exams, and one is selected each time you create a new 
exam. If there is no record in the system for the examiner who will be conducting the exam, you 
can create a record just before you add the exam.  Of course, you do not need to wait for an 
exam to enter the details of a new colleague joining your clinic or practice; you can follow the 
steps given below at any convenient time.. 

Follow these steps to create an examiner record: 

1. From the Tools menu, select Setup Examiners & Physicians..., or from the 
Patient/Exam tab, click the Setup Examiners & Physicians button. The Setup 
Examiners & Physicians dialog box opens. 

2. In the Select Examiner group box at the top of the dialog box, select <NEW 
EXAMINER>. 

3. Enter the Name of the examiner for the new record. The name entered must be unique 
in your system. 

4. Click the Create New Examiner button to add a record. 

 

Figure 15: Creating a new examiner 

5. If you need to create another examiner record, repeat the preceding steps.  Click the 
OK button to close the dialog box when you are done. The new examiner information 
may be associated immediately with new exams. 

 

Editing an Examiner Record 

You can edit an examiner record regardless of whether it is associated with any exams. You 
might want to edit the record if the examiner changes his or her name. 

Follow these steps to edit an examiner record: 

1. From the Tools menu, select Setup Examiners & Physicians..., or from the 
Patient/Exam tab, click the Setup Examiners & Physicians button. The Setup 
Examiners & Physicians dialog box opens. 

2. In the Select Examiner group box at the top of the dialog box, select the name of the 
examiner whose record you want to change. 

3. Change the Name of the examiner as desired. The name entered must still be unique 
in your system. 

4. Click the Save Changes button. 
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Figure 16: Editing and deleting an examiner 

5. If you need to change another examiner record, repeat the preceding steps; otherwise, 
click the OK button to close the dialog box. The changes are reflected on all existing 
exams, and the updated record is available to select for new exams. 

 

Deleting an Examiner 

You can delete examiner records from the database provided that no exams are associated 
with that examiner. InVivoVue warns against and prevents you from deleting an examiner record 
with associated exams.  

Follow these steps to delete an examiner record: 

1. From the Tools menu, select Setup Examiners & Physicians..., or from the 
Patient/Exam tab, click the Setup Examiners & Physicians button. The Setup 
Examiners & Physicians dialog box opens. 

2. In the Select Examiner group box at the top of the dialog box, select the name of the 
examiner whose record you want to delete. 

3. Click the Delete Examiner button (Figure 16). 

4. If you need to edit or delete another examiner record, repeat the preceding steps; 
otherwise, click the OK button to close the dialog box, and the old record is no longer 
available to select for exams. 

 

Exam Information 

Creating a New Exam 

When the program is started for the first time on a given day, an exam is automatically created 
for the anonymous patient.  If the user takes no action to select a different patient before 
acquiring data, that data will be associated with this ad hoc exam. 

However, to run an exam for a known patient, start by selecting that patient’s name on the 
Patient / Exam tab. Then, to create a new exam for a known patient, you can do any of the 
following: 

• Click the Add Exam button on the Patient / Exam tab. A new exam will be created, 
containing a single pending scan. 
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• Select an exam that patient took in the past and click the Copy Exam button.  An exam 
will be created, containing the same set of scans that were taken during that last exam, 
in the same order. 

• Navigate to the Imaging tab, drop down the exam actions list, and select Add Exam.  A 
new exam will be created with a single pending scan. 

 

• Navigate to the Imaging tab, drop down the exam actions list, and select one of the 
copy actions. 

o  If you choose Copy Exam, a new exam will be created with the same set of 
scans, in the same order, as the current exam. 

o  If you choose Copy Exam (Other Eye), a new exam will be created with the 
same set of scans, in the same order, as the current exam.  However, all the 
scans that were set up for the right eye (OD), will be set up for the left eye (OS) 
in the new exam, and vice versa.  (Some users find it handy to segregate all 
their right-eye scans into one exam, and all their left-eye scans into another.) 

Regardless of how the exam is created, be careful to associate the correct information with it.  
Being careful to enter this information will make it easier for you to locate exam data in the 
future. 

1. Select the examiner who will conduct the exam from the Select examiner drop down 
list. 

2. Select the physician who is overseeing the exam and review its results from the Select 
physician drop down list. 

3. Select the study with which this exam’s results will be associated from the Select study 
drop down list. 

4. Select a category with which this exam’s results will be associated from the Select 
treatment arm drop down list. 

Editing an Exam Record 

You can edit an exam record only on the day it is created. You can change the physician and 
examiner, as well as the associated study and treatment arm. To do so, follow these steps: 

1. On the Patient/Exam tab (Figure 4), select the patient record containing the exam you 
want to edit. 

2. In the Patient Exams group box, select the exam you want to edit, and the Edit Exam 
button is enabled. 

3. Click the Edit Exam button to open the exam editor. 
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Figure 17: Edit Exam and Delete Exam buttons located above the View Patient Details dialog box 

4. In the dialog box, select a different Study or Treatment Arm, and enter any Notes about 
the exam. Select a different Examiner or Physician. 

5. You can even enter the name of a new Examiner or Physician in the Add New... fields. 
If you do enter new names for either, click the Create... button to save the name and 
select it for the current exam. 

 

Note 
You can only edit exam information on the day the exam was created. After 
the date of the exam creation, you can only enter notes associated with the 
exam. All other fields are not editable.  

When you have completed your changes to the exam record, click the Save Changes 
button at the bottom of the dialog box (Figure 18). 
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Figure 18: Exam Details dialog box 

 

Deleting an Exam 

You can delete an exam record only if no saved scans are associates with it. If the exam has 
pending or abandoned scans, you can first delete them before deleting the exam. Follow these 
steps to delete an exam that meets the criteria: 

1. On the Patient/Exam tab (Figure 4), select the record containing the exam you want to 
delete. 

2. In the Patient Exams group box, select the exam you want to delete. If the exam meets 
the criteria for deleting, the Delete Exam button is enabled. 

3. If the exam has any pending scans, click the Start Exam button to view the details on 
the Imaging tab. (If the exam date is in the past, click the Review Exam button.) 
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Figure 19: Exams under Patient Exams box. Start exam button enabled 

4. Select each pending exam in turn, and click the Delete Selected Scan button to remove 
the scan from the list. 

5. When all scans are deleted, return to the Patient/Exam tab. 

6. Click the Delete Exam button, and the Confirm Delete message box opens. 

7. If you are sure you want to delete the record, click the Yes button, and the record is 
deleted from the database. 

 

Figure 20: Confirm Delete message box 

Finding an Exam 

You can filter for a particular exam by clicking on the title bar on the Patient Exams list 
(Figure 19). This will sort the list by that column header.  
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Imaging Tab 

Overview 

 

Figure 21: Imaging Tab 

The Imaging tab contains information and many controls to control imaging on the 
Envisu. The Patient Information Section (1) gives the current patient’s Name, ID, and MRN.  

The Patient Actions split button (2) contains any actions available to edit the existing 
patient or create a new patient. The default value for this button is to Edit Patient Details. The 
Edit Patient Details (2) action allows the user to edit the details of the existing patient. The 
Associate Patient (2) action allows the user to associate an anonymous exam with an 
existing patient, allowing the user to begin imaging immediately after opening InVivoVue and 
associate this exam with an existing patient after the fact. The Select Patient (2) action allows 
the user to identify an anonymous patient, and immediately begin a new exam for the selected 
patient. The Exam Information Section (3) gives the current exams date, time, and status.  

The Exam Actions split button (4) contains any actions available to edit the existing 
exam, create a new exam, or copy the current exam. The Edit Exam (4) action allows the user 
to edit the details of the existing exam. The Add Exam (4) action adds a new exam for the 
currently selected patient. The Copy Exam (4) action makes a copy of the current exam with 
all pending scans. The Copy Exam (Other Eye) (4) action makes a copy of the current exam 
with all pending scans with the opposite eye selection as the original. Edit Exam Notes (5) 
button allows the user to edit the notes for the current exam from the Imaging tab. 

The Physician (6) selector allows the user to associate the current exam with an 
existing physician. The Examiner (6) selector allows the user to associate the current exam 
with an existing examiner. The Study (7) selector allows the user to associate the current 
exam with an existing study. The currently selected scan’s File Name (8), Eye (25), and 
Index of Refraction (9) are also displayed. 

Change configurations using the Select Configuration (24) drop-down dialog. Load a 
protocol using the Load Protocol (10) drop-down dialog. The QuickStart Grid (11) enables 
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the user to quickly switch between scan types. Modify the current scan using the Dynamic 
Scan Control (16) window. Add a Preset Scan (17) or add a custom scan using the button 
on the far right of the control.  

Types may be selected during Aiming Mode but may not be toggled during Free Run 
mode. Aiming Mode is started using the Aim (12) button. Free Run mode is started using the 
Free Run (13) button. Once the Aim button is pressed, it turns into the Snapshot button, 
enabling the user to start a snapshot at the aiming location. Save the acquired data by 
pressing the Save (14) button. Save the associated raw spectral data by checking the Save 
OCU? (15) check-box.    

The OCT image is displayed in the B-Scan Window (18). The Volume Intensity 
Projection (VIP) (19) is displayed adjacent to the B-Scan. This window is replaced by the 
orthogonal aiming scan when aiming mode is enabled. The Display Line (24) identifies the 
location of the currently displayed B-Scan.  

Right-clicking on the B-Scan window shows the B-Scan Context Menu (Figure 22 and 
Figure 23). The Caliper menu allows selection of each of the calipers that may be placed on 
the B-Scan. Configure Calipers brings up the caliper configuration dialog, which allows the 
user to configure naming, horizontal or vertical locking, and display labels for the calipers. 
Save Calipers saves the current caliper configuration for later use. Fiducial Visible displays 
an on-screen reference marker that can be used during imaging to ensure the scan is placed 
in the same location every time. Fiducial Color allows you to set the color of the fiducial 
reference marker. Fiducial Position changes the position of the reference marker relative to 
the top of the display window.  

 

Figure 22: B-Scan Context Menu, Caliper Menu 
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Figure 23: B-Scan Context Menu, Fiducial Position Menu 

 The VIP Context Menu (Figure 24) includes the Caliper menu for placement of calipers 
on the VIP (configurable in the Configure Calipers option on the B-Scan Context Menu). SNIT 
Labels Visible toggles the display of the Superior (S), Nasal (N), Inferior (I), and Temporal (T) 
labels on the VIP and B-Scan windows. These labels assume an orientation based on the 
configuration used when loading InVivoVue. Cursor Visible toggles display of the green 
Display Line.   

 

Figure 24: VIP Context Menu 

 

Note 
When using the SNIT labels, the orientation of the labels are only accurate 
when the probe is held in the upright or 180 (supine) position in relation to 
the patient. 

 

The frame may be selected by dragging the Frame Selector Line (24) in the VIP 
window. The Playback Controls (20) enable skipping to the first and last frames, step ahead 
or back one frame, play, pause, or stop playback. The Frame Selector (21) allows the user to 
select the displayed frame. Acquired scans are shown in the Scan queue (23), and each 
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Scan (22) is displayed with a thumbnail image. The color indicates the eye imaged (yellow 
indicates OD, purple indicates OS).  

Right-clicking on a scan in the scan queue shows the context menu for each scan 
(Figure 25). Edit opens the scan editor and allows the user to edit the scan parameters. Save 
saves the current scan. Average registers and averages the scan if multi-frame data exists. 
Delete deletes the scan from the queue if no data has been saved for that scan. Load OCT 
data loads the currently selected file. Load R&A data loads the registered and averaged data 
if it exists. to Load OCU data loads the raw data if it exists. Go to Data opens the folder 
containing the selected data file.  

Both Load OCT and Load R&A options have an additional fly-out menu Send OCT to 
Diver if Leica’s Diver software is installed. This option will load the current file into Diver for 
analysis. 

 

Figure 25: Scan Context Menu 

 Right-clicking on the scan queue itself opens its context menu (Figure 26). Add 
QuickStart Scan adds a new scan corresponding to the current selections in the quick start 
grid; changing these selections will immediately update that scan. Add Custom Scan opens 
the scan editor to create a custom scan. Clicking Delete Pending Scans will cause scans for 
which no data has been acquired to be deleted. 

 

Figure 26: Scan queue’s context menu 

The Save As Protocol… option brings up a dialog that allows a name to be entered for 
the new protocol (Figure 27) to name the protocol and save the list of scans in the Scan 
queue as a new protocol. 

 

Figure 27: Save As Protocol dialog  
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 Scans added to exams that were never acquired are considered orphan scans, and are 
automatically deleted as soon this condition is detected (generally, the day after the exam 
took place).  Pending scans may be manually removed by selecting the Delete Pending 
Scans option. 

Pressing the Insert key has the same effect as the Add QuickStart Scan option. 
Pressing the Delete key will delete the currently-selected scan, but only if it data has not been 
acquired for it. 

Selecting Which Scans To Run 

The Quick Start Grid 

The area on the left of the Imaging tab with large green buttons is known as the quick start 
grid.  By making a selection from each row, a pending scan may be completely defined, with 
commonly-used options. The options present in the quick start grid will change, depending on 
which lens is in use; only choices that are appropriate for that lens will appear.  Clicking from 
one option to another will move the green highlight, to indicate what scan will be executed.  In 
addition, the text on the pending scan will change, reflecting those quick-start selections. 

           

Figure 28: Quick Start Selections 

To rapidly define an entire exam’s worth of scans, use selections from the quick start grid for 
the first scan, then press the Insert key to add a tile for the next scan to the scan queue. 
Continue making quick start selections and inserting new scans until the exam definition is 
satisfactory. 

Alternatively, you can define scans as the exam proceeds.  Use quick start selections to 
define the first, then acquire the data using the Aim / Free Run / Snapshot buttons.  Press 
the Save button to write the data to a file, and when the save action is completed, a new quick 
start scan is automatically added to the end of the exam, and selected in the scan queue. 
Clicking the quick start grid will now update that scan definition, until you are ready to perform 
the next scan.  You may continue in this fashion until the exam is complete.  It is safe to 
ignore the last pending scan automatically added, since it will be cleaned up automatically the 
next time InVivoVue runs. 
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Defining a Custom Scan 

If you want more precise control over the scan definition, or no option that corresponds 
directly to what you want is present in the grid, you may use the scan editor to enter exact 
details.  The scan editor may be invoked, either by right-clicking on the tile for a pending scan 
and selecting the Edit… option, or by right-clicking on the scan queue itself and selecting Add 
Custom Scan. 

In the middle of the scan editor are five green buttons, corresponding to the scan patterns 
InVivoVue is capable of executing.  Select the pattern of interest, and the columns beneath 
populate to show the details of the last custom scan defined for that pattern. 

The leftmost column contains the physical dimensions of the scan: how long and high it is, 
whether the scan should be tilted at an angle from the horizontal plane, and whether 
acquisition should begin at an offset from the aiming position.  These fields are limited by the 
physical hardware limits of the galvos used to position the beam, but otherwise any value may 
be entered. 

 

Figure 29: Defining a custom scan 

 

Note 
InVivoVue does not allow you to enter values outside of allowable ranges. If you 
enter a value beyond the range, InVivoVue automatically reverts to the value at 
the nearest end of the range and converts the characters to red font, to alert you 
to the condition. 

 

The middle column contains the dimensions of the data that will be acquired: how many A-
scans will be acquired per frame, how many B-scans will be acquired per volume, and how 
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many times the same volume will be acquired.  The number of times the same frame will be 
acquired for each B-scan may be increased from the default of one, although such multi-frame 
data must be registered and averaged as a separate step. 

Adding more A-scans, B-scans, and frame repeats will increase the precision of the images 
acquired, but will take longer to acquire and require more memory to buffer during acquisition.  
A rough estimate of how long each scan will take to acquire is shown on each pending scan 
tile.  The System Memory bar in the scan editor shows how much memory a given scan 
requires, relative to the amount of RAM installed.  While the memory bar is green, the given 
scan definition can certainly be executed. At around 70% of available memory, the bar will 
turn red; if you add this scan to the exam, the system may discover it is not able to actually 
run it.  Scans that would require more than 90% of available memory cannot be added to the 
exam; the Add to Exam button is disabled. 

A mixed-density volume is a rectangular scan with a single, high-density B-scan acquired at 
its center. The rightmost column will contain the dimensions of the data in the high-density 
region, when the mixed volume scan pattern is selected. 

In the Oculus Selection group, select whether you plan to scan OD or OS.  InVivoVue stores 
this information with the scan, although it is not capable of detecting whether the given eye was 
actually scanned. Users must be careful that the eye selected matches the eye actually 
scanned. 

Doppler information may be acquired at the same time as .OCT data. Again, acquiring this 
information will take additional time and require additional memory.  As the number of Doppler 
intervals is increased, the RAM requirements will update in the memory bar. 

For Envisu systems that have an internal fixation target, it may be useful to associate a 
fixation target with a scan. When the scan is acquired, that fixation target will appear as a 
background image for the subject.  To associate a fixation target with a scan definition, select 
a defined target from the drop-down list in the Select a Fixation Target group box.  

 

Note 
The Fixation Target control is used to identify the placement of a fixation target 
on Envisu products that include an internal fixation target. Running a scan on a 
system without such an internal target has no effect. 

 

 

Figure 30: Select Fixation Target group 

 

When you are satisfied with the scan definition you have created, click Add to Exam.  The 
scan editor will be closed, and a tile for the scan you have just created added to the end of the 
exam. 
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Creating Preset Scans 

If you use a certain scan definition frequently, you can save that definition as a preset. A preset 
can be quickly added to an exam by clicking the preset buttons to the left of the scan queue.  

 

Figure 31: Scan Preset buttons 

To define a preset, bring up the scan editor by right-clicking an existing pending scan and 
selecting Edit…, or by clicking the scan queue or an ongoing exam and selecting Add Custom 
Scan. 

When you define a scan using the scan editor, you have the option to save them as preset 
scans.  Define the scan as described above, then enter a descriptive name for your preset in 
the New Scan Preset group—something you will recognize when you pick it from a list of 
presets later. 

 

Figure 32: Naming a scan preset 

As soon as text is entered, the Create Preset button becomes enabled (as long as the name 
is unique).  You cannot create a preset scan for both eyes at once; instead, you must create 
separate presets for OD and OS, if that’s what you want. Click it to add your preset to the list 
of know presets; you should see it immediately appear in the Defined Scan Presets combo 
box at the top of the form. 

The Defined Scan Presets combo box is used if you want to apply the settings from a preset 
to the scan editor. Click the Copy Settings from Selected Preset button, and the scan 
editor’s fields will relflect whichever preset is shown in the combo box.  If you want to define a 
new preset that is close to, but not exactly equal to, an existing preset, a fast way to fill out the 
fields is to begin by using this button. 

Using the scan editor to define a scan preset does not automatically add it to the exam.  You 
must still click the Save Changes button to do so. 
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Defining a Scan Protocol 

You can create a new scan protocol using the collection of scans for an exam, whether a current 
exam or an exam from the past. If your objective is simply to create a new scan protocol, 
regardless of any actual exam, you can do that, too. If there are no exams from which you want 
to create a scan protocol, you might want to create a test record and an exam solely for creating 
the new scan protocol; in this way, you avoid altering actual records. 

In the following procedure, you will create a patient record and an exam record and add scans 
to the exam, all for the purpose of creating a new scan protocol. After creating the scan protocol, 
you will delete the information, to eliminate any false information from the system. 

1. From the Patient/Exam tab, select the test patient (ID = Test-01). 

2. Add an exam to the patient record, and click the Start Exam button. InVivoVue takes 
you to the Imaging tab. 

 

Figure 33: Start Exam button located in Patient Exams box 

3. Add the scans for your new scan protocol to the exam, by creating customized scans or 
adding preset scans. 

 

Figure 34: Preset Scan Buttons 

4. If you have an existing scan protocol that contains scans similar to the new one you 
want to create, add the scans from that existing protocol. 

5. For any scans you add from preset scans or another scan protocol, edit them to define 
the correct scan parameters for the new scan protocol. 

6. Delete any unwanted scans if you added the scans of an existing scan protocol. 

7. Save the protocol using the context menu in the Scan queue (Figure 26).  

 

Note 
If the name you enter is not unique, a "!" symbol appears to the right of the name 
field, and the Save Protocol button is not enabled. 

8. After saving the new scan protocol, delete all scans from the exam, and return to the 
Patient/Exam tab. 

9. On the Patient/Exam tab, delete the exam that you created for this procedure. 
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Adding a Scan Protocol to a Study 

You can add one or more scan protocols to a study when you create the study record or later 
by editing the study record. If the protocol you want to add does not already exist, you first need 
to define a new one. For more information, select from list of Related Topics below. 

To add an existing scan protocol to a study, follow these steps: 

1. On the Study tab, select the study for which you want to add a scan protocol, and click 
the Edit Study... button. The Edit Study dialog box opens. 

2. In the Scan Protocols list at the bottom of the dialog box, select one or more items from 
the Available Protocols list, and click the Add>> button. The selected protocols are 
moved to the Scan Protocols in Study list. 

3. When you are finished adding protocols to the study, click the Save Changes button at 
the bottom of the dialog box, to close it and save your changes. 
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Leica Image Data 

Types of File Created by InVivoVue 

InVivoVue uses files of several file types, including proprietary and common use, to store data 
and images for the software. The following is a list of each of the possible file types along with 
a brief definition of each: 

.OCT: A Leica file format containing processed, viewable images with a file header. 

.OCU: A Leica file format containing raw spectral data of the scan as unprocessed 
images. 

.RAW: A file containing the .OCT image data in a raw array of bytes without a header.   

.UNP: A file containing unprocessed, viewable images as a raw array of bytes without a 
header. 

.BMP: A device-independent file for storing and rendering viewable images, especially on 
the Microsoft Windows operating system. InVivoVue uses .BMP files to store 
single-frame images of the B-Scan, Volume Intensity Projection and Video Fundus 
windows, as well as thumbnails used in the UI and in reports. 

Whenever InVivoVue saves an image scan, it saves the following files: 

• raw spectral data of the scan, .OCU file extension (if selected using the Save OCU? 
check-box) 

• processed data of the scan, OCT file extension 

• bitmap image of frame 0 (zero) of the B-Scan, .BMP extension 

• bitmap image of the fundus image, .BMP extension 

• bitmap image of the VIP window (for volume scans only), .BMP extension 

 

Loading Images from OCU Data 

On occasion, you may want to load the OCU (raw spectral data) file for an image.  For example, 
you might want to use InVivoVue’s algorithm to optimize image dispersion to improve the quality 
for viewing. Whatever the reason, you can load OCU data in either of two ways: You can select 
an image outside of your own database, or you can load OCU data for any saved image in your 
database. 

To load OCU data for images in your database, follow these steps: 

1. On the Patient/Exam tab, select the exam containing the data of interest. 

2. Navigate to the Imaging tab. 

3. Right-click a saved scan from the Scan queue to display the scan context menu. If .OCU 
data is present, the Load OCU Data menu item will be enabled. Click it to load the 
spectral data. 
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InVivoVue Configuration 

Switching Configuration 

InVivoVue installs with configurations designed for a wide variety of uses.  For acquisition 
systems, typically you will select a particular configuration depending on what type of lens you 
have mounted.  InVivoVue will respond by loading new settings for that configuration, 
updating the UI, and subsequent scans will use whatever new hardware settings apply. 

The Select Configuration combo box appears at the top left of the Imaging tab.  The current 
configuration is shown. 

 

Figure 35: Configuration Selection 

When the combox box is clicked, a list of the known configurations is shown. Selecting a new 
configuration will cause InVivoVue to load and apply the applicable settings, and to update the 
current configuraiton display.  This will also cause InVivoVue to start up in the new 
configuration, the next time it is run. 

 

Figure 36: Standard Configurations 
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Changing Program Defaults 

As you work with InVivoVue, you may want to change some of the default settings that load with 
a particular configuration. 

InVivoVue has configurable settings for many things, including: 

• Display of image scans (brightness, contrast, Doppler adjustments, etc.) 

• Fixation target (size and position of the target) 

• Fiducial display (on/off, position, color) 

• Image processing (processing and resampling controls such as dispersion ) 

• Scan type (linear B-Scan, annular volume, mixed volume, etc.) 

• Caliper configuration (names, color, angle lock, display length & location) 

These settings can be changed from many places. For example, 

• Display of image scans settings are changed in the Display Options dialog. 

• Fixation target settings are changed in the fixation target area 

• Fiducial display settings are changed in the B-scan display’s context menu 

• Image processing settings are changed in the processing control form. 

• Scan type settings are changed in the scan editor. 

• Caliper configuration settings are changed in the Configure Calipers dialog. 

But settings changed in this way only affect the program while it is running.  When the program 
is shutdown, it will forget the changes you made, unless you update the loaded configuration 
file. 

Determine current user configuration 

To determine which user configuration file is loaded, open the System Information dialog 
under the Help menu.  The name of the user file is shown.  Hovering the mouse over the file 
name will show its complete path. 
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Figure 37: System Information - User Configuration File 

Saving new user configuration settings 

You can replace the default settings stored in this user configuration file by following these 
steps: 

1. Configure InVivoVue as desired, using the tools described above. 

2. From the Tools menu, select Save Settings... 

 

Figure 38: Tools Menu 
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Figure 39: Save Settings File dialog box 

3. In the resulting file selector, select the user configuration file named in the System 
Information dialog. 

4. Click the Save button to save your settings. A message opens for you to confirm that 
you want to replace the existing file. 

5. Click Yes to close the message window and the dialog box. 

The settings you save become your default settings until you change them again. 

 

Example: change default settings for the image display 

For example, the brightness and contrast values InVivoVue applies at start up can be 
changed by following these steps: 

1. Select the Imaging tab. 

2. On the left B-Scan display area, right-click and select the Display Options… item. The 
Display Options dialog is shown.  

 

Figure 40: Edit Display Options Dialog box 

3. Drag the brightness and contrast sliders to new values. 
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4. Determine your current user configuration 

5. Save the new user configuration. 

 

Example: change default settings for image processing 

1. From the Tools menu (Figure 38), select Configure Processing... The Processing 
Control dialog is shown. 

 

Figure 41: Image Processing and Resampling Controls 

2. Make the desired changes on the Processing and Resampling tabs. 

3. Determine your current user configuration 

4. Save the new user configuration. 

 

Example: change default scan settings 

To change the settings for scan types, you must first create a custom scan of type you want to 
change. To create a custom scan, you must add it to an exam in order to save its settings as 
your default for that type of scan. You can create the custom scan during the course of an actual 
exam or by creating a 'dummy' exam that you then delete from the system. In either case, follow 
these steps. 

1. On the Patient/Exam tab, create an exam or select a current exam from today, and click 
the Start/Continue Exam button. InVivoVue displays the exam on the Imaging tab. 

2. Right-click on the scan queue and select the Add Custom Scan option. The scan editor 
is displayed. 
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Figure 42: New Scan dialog box 

3. Select the desired scan configuration, and click the Add to Exam button. 

4. Save your settings as described above. 

The values you saved now become the default values for exams of that type. 

 

Creating a New User Settings File 

As discussed above, a variety of system settings are stored by default in user configuration files. 
Each time InVivoVue is started, the system will begin with settings in place that reflect the 
configuration that was running during the last session. 

Some users might find it helpful to store more than one set of default system settings; for 
example, if you are conducting multiple studies with markedly different protocols, you might 
want to create different default values for the various scan types. If so, you can change the 
defaults accordingly and store them in a different .INI file, allowing you to load these alternate 
settings whenever the need arises. 

To create a new settings file, follow these steps: 

1. Refer to the information in Changing Program Defaults to learn what settings you can 
change and how to change them. 

2. After you complete any changes you want you want to make, from the Tools menu, 
select Save Settings... 

3. In the resulting save dialog, enter a file name for the new settings file.  By convention, 
Leica prepends the string User_ to user configuration files; we recommend that you 
follow this convention, as well. 

4. Click the Save button to save your settings. 
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You can create as many of these alternate settings files as you need and switch between them 
whenever the need arises. To switch from the current settings to another set of default settings, 
follow the steps below. 

 

Loading an Existing Settings File 

From time to time, you may need to load or reset the default settings for various areas of the 
system. For example, if you find that default values have changed for such things as the display 
of image scans, the processing of image scans, or the fixation, you can restore them. Or if you 
have previously created an alternate settings file, you can then switch between existing settings 
files. 

In either case, follow these steps to load or restore the values from a system settings file: 

1. From the Tools menu (Figure 38), select Load Settings... to open the Load Settings File 
dialog box. 

 

Figure 43: Load Settings File dialog box 

2. In the dialog box, select the name of the file containing the settings you want to load or 
restore. 

 

Note 
The values for configurable settings are stored in .INI files whose names 
begin with User_. It is possible for settings to be stored in an .INI file that 
does not follow this naming convention. For example, you may want to 
avoid selecting the LineSpectrum.INI, because this file is used only for 
checking the line spectrum. 

 

3. Click the Open button to load the settings file and close the dialog box. 

The Image Processing, Fixation, and Display Option settings you load become the default 
settings for the system until you change them again.  The default scan parameter settings 
(dimensions, angle, lines, scans, frames, etc.) are not restored when dynamically loading a 
systems settings file. 
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Data Management 

Loading an .OCT file without patient data 

Occasionally, it may be useful to load an .OCT (or .OCU) file for which you have no patient 
information: a colleague may have shared the data (without using the export feature, which 
preserves patient information), or someone may have accidentally moved some InVivoVue 
files from where they were stored by the program.  Under the File menu is an Open… option.  
Clicking it brings up a normal file selection dialog.  Use it to select the file of interest resides, 
and: 

• InVivoVue will create an exam under the anonymous patient, whose date stamp 
matches the creation date of the file selected, then a scan record matching the details 
inferred from the file header.  This will cause a tile to appear in the Imaging tab when 
that exam is selected. 

• If both the .OCT and .OCU files are found, both will be made a part of that scan record.  
Otherwise, only the file selected will be added to the scan. 

• If an exam for that date already exists, the scan will be added to that existing exam. 

• The file will be immediately loaded. If an .OCT file is selected, the data will be 
immediately displayed.  If an .OCU file is selected, the data must be reprocessed 
before it is displayed. 

This feature is intended as a backup: a way of recovering if a user error occurs and no patient 
/ exam information is available to the program.  You should avoid treating it as a normal 
operation, as it will become increasingly difficult to identify data if you have loaded it into the 
anonymous patient. 

Archiving Exams 

Archiving data is the process of physically removing the data files from your computer.  The 
data files InVivoVue collects are quite large, and without removing them from the system, the 
computer’s hard drive will eventually fill up.  Leica strongly recommends archiving exams when 
available disk space falls below 10% of total capacity; in fact, you will receive a warning every 
time you click the Save button, if you are running out of hard disk space, until you do something 
about it. 

After exams are removed from the Envisu, it is occasionally useful to get the files back, for 
example to look at old data to prepare for a new exam.  When you archive data, you specify to 
where the files should be moved.  InVivoVue keeps track of where the files are copied, and uses 
that information to quickly get them back, when you ask them to be retrieved. 

Because of the large size of images, archiving requires a storage location with a large amount 
of available space, such as a network drive or secondary storage devices, such as one or more 
external drives.  

While archiving is going on, InVivoVue will not allow you to perform other tasks.  The duration 
of the archiving process will depend heavily upon how many exams you archive at once. It is 
best to schedule archiving for a quiet time that the Envisu is not needed for examining patients.  
Once the exams to archive have been selected and archiving initiated, the system does not 
need to be attended; InVivoVue will complete the archiving activity on its own (unless it runs out 
of space on the archiving destination). 

To archive exams, follow these steps: 
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1. From the Tools menu (Figure 38), select Archive Scans... The Archive Exams dialog 
is displayed. 

 

Figure 44: Archive Exams dialog box 

2. All exams that are not already archived are listed in the Archivable Data group box by 
date, with the oldest exams appearing at the top.  The exams are grouped by month and 
date, to make it easier to select entire sets of exams for archiving together. 

3. Double-click each date to add all exams to the Selected Exams group box.  
Alternatively, expand the month nodes to show individual dates, and the date nodes to 
show individual patients.  Double-click the items you wish moved off your system.  As 
you do so, the exams affected will appear in the Selected Exams group, with text 
indicating how many files and their relative size.  The bar underneath reflects how much 
of the available space on the archiving destination will be used up by archiving. 

4. You can select all exams prior to a given date by entering a date and clicking the Select 
All Exams Prior To button. All exams in your system that took place before the date 
you selected will be added to the Selected Exams group. At the bottom of the window, 
the Required Space field shows how much storage space is required to store the 
selected exams. 

5. Use the Browse button at the top of the dialog to select the location to which you want 
files archived. The Available Space field will be updated to show how much storage 
space is available on the volume (network drive, external device, etc.) selected. 

6. Click the Start Archiving button, and InVivoVue begins moving the image files for the 
exams you selected to the archiving location. 

Remember, the process can take many minutes to complete, so be sure you have enough time 
available without interrupting patient exams. 

 

Retrieving Archived Scans 

Archived scans and reports are removed from the system and stored in another location. If you 
find that you need to refer to archived scans and reports, InVivoVue allows you to retrieve them. 
The Retrieve Archived Scans function moves selected scans and reports from the archive and 
restores them to the original location on your system. 
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Like archiving, retrieving scans locks your computer system, preventing you from performing 
any other tasks, and depending upon how many scans you retrieve, the process can take quite 
a while. So you should not retrieve scans at any time that you need your system for other tasks, 
such as examining patients. 

The easiest way to retrieve the data for a single exam is to navigate to the Patient / Exam tab, 
find the archived exam of interest, and double-click the Y under the Archived column.  You will 
be prompted to confirm that you wish to retrieve the exam data. 

To retrieve a number of exams at once, follow these steps: 

1. From the Tools menu (Figure 38), select the Retrieve Archived Scans... option. The 
Retrieve Exams dialog is displayed. 

 

Figure 45: Retrieved Archived Exams dialog box 

2. In the Retrievable Data group box, all data available for retrieving is listed alphabetically 
by patients' names.  

3. Select each patient for whom you want to retrieve data, and double-click the name or 
click the >> button to move it to the list in the Selected Exams group box. 

4. If you only want to retrieve data for individual exams, click the + button to drop down a 
list of exams by date for each patient, and select the ones to retrieve. 

5. Exams you select for retrieval are moved to the Selected Exams list and are shown 
along with the file path to the original location where the data will now be restored. In 
addition, the Space Needed field shows how much total space is needed for the 
retrieved images and how much is available on your system. 

6. Click the Start Retrieving button, and InVivoVue begins moving the image files for the 
exams you selected to the original location. 

Remember, the process can take many minutes to complete, so be sure you have enough time 
available without interrupting patient exams. 

Some sites use multiple network locations for archiving, others use a series of external drives, 
and after some time, it can be difficult to remember to where data was archived.  If you find you 
cannot remember where an exam is archived and need to know to make sure a device is 
connected before retrieving, select the exam, navigate to the Imaging tab, and mouse over one 
of the scan tiles. The archive path will be shown on the tooltip. 
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Exporting Exams 

Exporting is the process of making a copy of a exam’s data, which can be used to share with 
another system.  It does not remove data from your system; in fact, if you make the copy on the 
Envisu’s hard drive, you will have less space until the export copy is removed. 

Importing is the process of adding files previously exported from an Envisu system and making 
them locally available on a reader system, or a colleague’s InVivoVue installation.  It adds the 
files in an export copy to the import system. 

You can export an exam to make a copy of all patient and image data associated with the exam. 
In addition, exporting creates files for importing into a central database; these can be used in a 
read-only version of the program. InVivoVue also provides the choice to export with or without 
the information that identifies patients. You can export to your computer, a network drive or a 
DVD and export a version usable with InVivoVue 1.4. 

When you export an exam, InVivoVue copies all the files for each scan in the exam.  The exact 
number depends on the scan pattern, and whether reports were created. The total amount of 
disk storage space necessary to store exported exams can be significant; for example, the files 
exported for a linear scan can total 170 megabytes (Mb) or more, and the files for a volume 
scan can exceed 400 Mb. So be sure that you have adequate space on your computer, network 
drive or (especially) USB. 

To export a patient exam, follow these steps: 

1. On the Patient/Exam tab, select the patient for whom you want to export data.  

2. In the Patient Exams group box, select the specific exam to export from the current patient 
record by clicking under the Export column. The column changes to show a green arrow, 
indicating the exam has been marked for export. Mark as many exams as you like, across 
multiple patients if appropriate. As exams are marked for export, the text of the export 
button changes to reflect how many are scheduled: Export 1 Exam, Export 2 Exams, 
and so on. 

 

Figure 46: Selecting a single exam to export 
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Figure 47: Selecting multiple exams to export 

3. When all the exams to be exported are marked, click the Export Exam button. The 
Export Exams dialog box opens. 

4. The dialog initially shows the path under which the export files will be created, in the 
Export to text box.  The path is determined by the EXPORT_PATH setting in the user 
configuration file, and will start at the same place each time the program is run; by 
default, that is D:\Bioptigen\Export. The Export to text box is not directly editable. To 
change the path under which export files are stored, click the folder icon next to Export 
to and use the resulting folder selection dialog to browse to an appropriate location.  
InVivoVue no longer requires an empty folder for exporting, as it creates the requisite 
subdirectories itself. If you want to create a folder now, click the Make New Folder 
button to create a new empty folder for the exam data, and give the folder a name 
relevant to the information you are exporting.  Take care to select a location where there 
is adequate disk space. 

5. If you want to include identifying information about the patient, click the checkbox, when 
exporting exam, include patient identifiers, located below the list of exams. The 
patient ID, birth date and name will be included in the exported data. If you choose to 
exclude identifying information, the patient's name is withheld, and the birth date defaults 
to 01 January 1901. 

6. If you want to copy the exam data files, click the when exporting exam, make copies 
of the data files check box.  If you choose not to copy the data files, the export will go 
much more quickly, but the data will not be found when you import, and you will have to 
manually locate the data files. 

7. The format of exam exports has changed slightly with versions after InVivoVue 2.0.  If 
you wish to export data for reading on an InVivoVue 1.4 system, check the Create 
export files for use by InVivoVue 1.4 reader box.  If you do not check this box, imports 
into a 1.4 reader will fail. 

8. The exams you marked for export appear in the list on the left. You have one last 
opportunity to deselect exams by un-checking the box next to their name. 

9. When you have made all appropriate changes, click the Start Export button. InVivoVue 
creates a subfolder named ExamDate_MM.DD.YYYY for each unique exam date. 
Beneath that, it creates a subfolder named 
PatientID_XXX_Exported_MM.DD.YYYY_Export_nn (where XXX is the patient's ID, 
the date is when the exam was exported (today), and nn is the number of times that 
patient has had exam data exported on that date.). Knowing this folder organization is 
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not critical; InVivoVue should be able to find files when you import on the reader system. 
InVivoVue then creates a pair of .SQL files in the 
PatientID_XXX_Exported_MM.DD.YYYY_Export_nn folder, and (if the data files are 
being copied) the exam data is copied to the subfolder with today's date. The dialog box 
closes. 

 

Importing Exams 

Importing is the process of adding files previously exported from an Envisu system and making 
them locally available on a reader system, or a colleague’s InVivoVue installation.  It adds the 
files in an export copy to the import system. 

You can import into your site an exam that was exported from another InVivoVue site (at 
Release 1.1 and higher) and view the imported exam and its associated scans and reports.   

InVivoVue will detect whether exam and image files already exist on your site, to help you avoid 
importing the same exam twice.  If the files are already present, InVivoVue will ask you whether 
to continue, thereby overwriting the existing files.  

To import an exam, follow these steps: 

1. From the Tools menu (Figure 38), select Import Exam. A folder selection dialog will 
open.  

 

Figure 48: Browse for Folder dialog box 

2. In the dialog box, find the exam folder on your computer that contains the exam you wish 
to import.  Do not expand the exam folder to select the sub-folder that is named 
PatientID_XXX (where XXX is the patient’s ID number).  The import will fail if you select 
the Patient ID folder. 

3. Click the OK button. InVivoVue inserts the contents of the exam folder into your site’s 
database and stores the exam’s scans and reports on your default save drive.  The 
dialog box closes. 

When an exam that was created on another InVivoVue site is imported into your site, a Switch 
Sites… button appears on the Study tab.  Clicking on this button opens a dialog box that allows 
you to switch to the site associated with the freshly imported exam so that you may review it. 
(Refer to the information in Reading Imported Data to learn more about the using the InVivoVue 
application as a reader application.) 
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Reading Imported Data 

InVivoVue allows imported exams to be viewed on other InVivoVue scanners (at Release 1.1 
and higher).  When an exam is imported, all information associated with the exam is imported 
as well.   

This includes the: 

• Site information – The site identifies the InVivoVue scanner on which the image was 
acquired.  The hardware and software in use at the time of the image acquisition is 
imported along with general site information, like site name and site description.  Leica 
refers to other InVivoVue sites as non-native sites and the site into which exams are 
being imported as the native site. 

• Study and Treatment Arm information – This is the study and treatment arm information 
associated with the exam, including protocol information if the exam’s scans were 
loaded from a scan protocol. 

• Patient information – This information is limited to the information at the time of the 
export.  If the exporter requested to omit identifiers, then the actual name and date of 
birth are omitted. 

• Exam information – This includes all information about the exam, including the physician 
and examiner. 

• Image scans and reports – This includes all of the image files and reports that were 
saved with the exam 

• Fixation Presets – This includes any fixation presets that were explicitly associated with 
a scan. 

After an exam that was created on another InVivoVue site is imported into your site, InVivoVue 
displays the name of the site you are currently viewing at the top of the Study tab and a Switch 
Sites button.  Clicking on Switch Sites button opens a dialog box that allows you to switch to 
the site associated with the freshly imported exam so that you may review it.   

To view an imported exam, follow these steps: 

1. From the Study tab, click on the Switch Sites button and the Display Data From Which 
Site? dialog box will open.  Select the site from which the imported exam originated, 
then click the Choose Other Site button. 

 

Figure 49: Switch Sites... button 
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Figure 50: Display Data from Which Site? dialog box 

2. The selected site is made the current site and the site name is displayed on the main 
window’s title bar, and also at the top of the Study tab to the right of the Viewing      Data 
From label.  The study associated with the imported exam is displayed in the list of 
Studies. 

3. Click on the Patient/Exam tab to see a list of patients associated with exams that have 
been imported into the selected site.  You can either use the Find Patient group box at 
the top of the tab or the List Patients group box below it to locate the patient that is 
associated with the imported exam you want to view.  

4. Select the imported record from the list, and basic information from the record is 
displayed in the View Patient Details group box at the bottom right of the tab.  Imported 
exams that are associated with the patient are displayed in the Patient Exams group box 
above the View Patient Details group box.  

5. Select the imported exam from the Patient Exams list and click on Review Exam button 
to view the scans associated with the imported patient exam. (Or, you may select the 
exam and click on the Imaging tab to review the scans.) 

6. Refer to the information in Loading Scans to learn more about using the InVivoVue 
application to view image scans. 

7. To return to the native site, open the Display Data From Which Site? dialog box (by 
clicking the Switch Sites button on the Study tab) and click the Choose Native Site 
button. 

When working with a non-native site you may view all imported information associated with that 
site.  Specifically, InVivoVue will allow you to: 

• View all imported study information associated with the non-native site. 

• View all imported patient information associated with the non-native site. 

• View all imported exam information associated with the non-native site, including the 
physician that presided over the exam and the examiner that acquired the images. 



 User Interface 
 

9054-10054 Rev E  Page 55 of 120 

• Export imported exams associated with the non-native site. 

• View imported image scans associated the non-native site.  This includes the ability to: 

o  Load the .OCT file and play it back. 

o Load the .OCU file and reprocess it. 

o Save the .OCT and/or .OCU file(s) using the Save As… function from the Tools 
menu.  

o View the image scan in 3D View (must be rectangular volume scan). 

o Print the B-scan and VIP windows. 

o Print and save reports. 

• Archive imported exams associated with non-native site exams.  In fact, Leica 
recommends archiving both native and non-native site exams to manage disk storage. 

• Retrieve imported archived exams. 

When working with a non-native site you cannot modify any of the information that is displayed.  
Specifically, InVivoVue will not allow you to: 

• Add a study and/or treatment arm to a non-native site; nor can you modify or delete a 
study and/or treatment arm associated with a non-native site. 

• Add a patient to a non-native site; nor can you modify or delete a patient associated with 
a non-native site. 

• Add an exam to a non-native site; nor can you modify or delete an exam associated with 
a non-native site. 

• Add an examiner or a physician to a non-native site; nor can you modify or delete an 
examiner or a physician associated with a non-native site. 

• Add a scan to an exam that is associated with a non-native site; nor modify or delete a 
scan that is associated with a non-native site. 

• Acquire a scan when working with a non-native site. 
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Daily Workflow 

Conducting an Exam 

 Exams are conducted on the Imaging tab.  When InVivoVue first starts, an anonymous 
patient is generated, with an ID derived from that day’s date.  The patient details can be 
entered, or the anonymous nature of the exam can be eliminated by associating it with an 
existing patient, either before or after the exam, as the user finds convenient.  The controls for 
doing so appear in 

Figure 21.  

This patient’s exam is initially populated with a single scan, whose properties are 
determined by the selections in the quick start grid.  This grid contains buttons that determine 
the geometry, physical dimensions, and data density of the scan to be collected.  The exact 
settings are determined by configuration files on the user’s system and may vary from system to 
system, but hovering the mouse over any of the buttons will cause a tooltip to be displayed, 
indicating the settings implied by that button.  By selecting one button from each row, using the 
description on the button and in the tooltip, the user can choose a scan that is appropriate for 
the patient. 
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Figure 51: Imaging Tab with Image Data 

As different quick-start choices are made, the button highlights move, and the thumbnail 
item of the corresponding pending scan is also updated.  Since InVivoVue cannot independently 
determine which eye is being scanned, this thumbnail item is color-coded to match the eye it 
believes is correct: yellow for the right eye (OD), and fuchsia for the left eye (OS).  The user can 
toggle the eye selection by double-clicking the thumbnail, and the text description and 
background color will update accordingly. 

When the scan settings are satisfactory, the user can initiate data acquisition by clicking 
the Aim button.  This begins a crosshair scan: two rapidly-alternating linear scans at right 
angles, one horizontal and the other vertical.  The surface being imaged appears in the primary 
and secondary B-scan displays. 
 

On systems configured with a video camera, an image of the fundus appears in the 
window labeled Dynamic Scan Control.  Overlaid on this live image is a graphic representing the 
physical area being scanned, called the Dynamic Scan Control graphic. To obtain an image of 
an area of interest, the user can adjust his aim of the handheld probe, or he can drag the 
handles on the dynamic scan control graphic to change it horizontal and vertical offsets, its 
width and height, and the angle of the scan.  The B-scan display will update in real time, as will 
the text description in the thumbnail. 

When the user is satisfied with her aiming point, she clicks the Snapshot button.  This 
collects an entire volume of data, with the scan settings indicated in the thumbnail.  In contrast 
to the aiming scan, this scan can take up to many seconds, depending the data density 
selection that was made from the quick start grid; the physical dimensions of the scan do not 
have any observable effect on the acquisition time.  While the volume is being collected, the 
vertical aiming display is replaced by a volume projection, which slowly accumulates.  The B-
scans acquired are displayed in real time, as they are received. A green highlight line on the VIP 
tracks the position of the B-scan. 
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 After the volume has been completely captured, the scanning stops.  The user can 
review the data acquired by examining the VIP, or by using the Playback Controls located to the 
left of the list of scans (the so-called Scan queue).  The Playback Controls function as all VCR-
style controls do: the user can step forward or backward by a single frame, move to the very first 
or last frame in the volume, animate the frames in the B-Scan Display by cycling through the 
frames as they were acquired, or stop this animation on a particular frame of interest.  The 
playback rate is based on the rate at which frames were acquired. 

 If the data is not satisfactory, the entire acquisition sequence can be repeated, replacing 
poor data with better images.  No prompt is issued if the user opts to re-start imaging: the 
program assumes the examiner knows what she is doing.  In addition, the data acquired can be 
entirely discarded merely by selecting and starting a different scan, although in this case, there 
is a warning. 

 If the data is of as quality to preserve, however, clicking the Save button copies the data 
from memory to disk files.  Several files are created.  InVivoVue always saves the spatial data 
(the data displayed on screen as B-scans) in a file with the .OCT extension.  These files may be 
loaded later for playback, caliper measurements, and reports.  If the Save OCU? check-box is 
checked, InVivoVue also stores a copy of the spectral data (the raw data acquired from the 
spectrometer) in a file with the .OCU extension.  In addition, a bitmap image of the frame that is 
visible in the primary B-scan display is saved (and appears on the Scan queue thumbnail as 
soon as the save completes).    For volume scans (everything except a linear scan), a bitmap 
image of the VIP is saved.  Finally, on systems equipped with a fundus camera, a bitmap still of 
the fundus, taken at the moment the snapshot was started, is also saved. 

 

Selecting a Patient 

Exams typically begin by selecting the patient for whom the exam is being conducted. To 
conduct an exam, you must first select an existing patient record or create a new record. To select 
an existing record, follow the steps below. If you need to create a new record, follow the steps in 
Adding a Patient or use the Anonymous Patient created by InVivoVue.  

1. At the top of the InVivoVue application window, select the Patient/Exam tab. 

2. To select an existing record, you can either use the Find Patient group box at the top 
of the tab or the List Patients group box below it. 

 

Figure 52: Find Patient box 
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Figure 53: List Patients box 

3. To find a patient record, enter part or all of the record information in the Patient ID, 
Patient MRN, and First Name or Last Name fields in the Find Patient group box. As 
you type in any field, InVivoVue selects the first record it finds in the List Patients group 
box that matches the information you entered. 

4. Alternatively, you can select a record from the List Patients group box. You can find 
patients by their exam dates.  Enter a date (or use the calendar option by clicking the 
down arrow beside the date text box) in both the From and To date fields.  Records that 
match your selection are displayed in the list below your selection. 

You can sort the list of records by any of the columns; to sort, simply click on the column 
heading. Clicking on the same header twice reverses the sort order. 

5. Select the desired record from the list, and basic information from the record is displayed 
in the View Patient Details group box at the bottom right of the tab. 

6. Next, you must set the exam defaults. 
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De-anonymizing a patient 
 
You can identify who an exam is for while you are conducting an exam associated with the 
anonymous patient by using the patient controls at the top of the Imaging tab. 

 

Figure 54: Anonymous patient exam 

 
Click the drop-down arrow and select Select Patient.  A dialog is shown, containing the same 
patient selection and filtering controls as described above.  Select the actual patient, and the 
exam will be reassigned to that person. 
  
If the patient has not yet had patient data added to the system, select Associate Patient 
instead.  In this case, the patient editor will open, exactly as if you had clicked the Add 
Patient button on the Patient/Exam tab.  When you have finished entering the new patient 
details, click the Save & Exit button. The new patient will be added to the system, and the 
exam associated with her. 
 
Selecting Select Patient does the same thing: It associates the current exam with a patient 
selected from the list of known patients, plus it starts a brand-new exam for that patient.  You 
can use Select Patient to start exams for known patients, as well as de-anonymizing an 
exam. 

Setting Exam Defaults 

Once you select the patient for an exam, you should note which examiner, physician, study and 
treatment arm are associated with that exam. You can change any of the entries, either by 
selecting other existing values or by adding a new examiner or physician. 

Follow these steps to verify or change the defaults for the current exam: 

1. On the Patient/Exam tab, locate the Set Exam Defaults/Add Exam group box at the 
upper right of the tab. 

 

Figure 55: Set Exam Defaults/Add Exam box 

2. Check the entries for Examiner, Physician, Study and Treatment Arm to ensure they 
are correct for the patient's current exam. 

3. If you need to change any of the entries, select a new entry from the drop-down list for 
that field. 

4. If you need to create an entry for a new examiner or physician, see the sections to setup 
Examiners and Physicians. 

5. After selecting all the defaults for this exam, click the Add Exam button, and the exam 
record is added to the list of exams for the current patient. 
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6. If you make a mistake or want to change any of the exam defaults, you can edit or delete 
the exam record 

7. When you have successfully added an exam to the patient's record, select the exam 
from the list in the Patient Exams list, and click the Start Exam button. InVivoVue then 
takes you to the Imaging tab. 

8. Now you can select the types of scan for the selected exam. 

 

Choosing a Scan 

Before you can acquire images for a patient, you must add one or more types of scan to the 
patient exam. You can select either preset scans associated with a protocol, individual preset 
scans, or you can create customized scans for the patient. 

 

Note 
You can only add scans to an exam that has the current (today's) date. For 
exams dated in the past, you can only delete scans for which the Status is 
'Abandoned;' all other functions for adding or editing scans are disabled. 

 

Follow these steps to select preset scans: 

1. Select the Imaging tab. 

2. To quickly define a single scan using typical scan settings, you can click on any 
combination of the buttons in the quick start grid. The selected pending scan in the Scan 
queue will change to reflect the scan parameters corresponding to your selections. 

3. To add individual preset scans, click a Preset scan button, each of which represents 
one of the scan patterns InVivoVue understands.  The Add preset to exam dialog will 
be displayed, and you can select from the listed presets.  The selected preset scan will 
be added to the Scan queue. 

4. To get the exam to execute a specific protocol, choose that protocol from the Load 
Protocol drop-down list.  All of the scans in that protocol will be added to the Scan 
queue. 

5. You can also define custom scans to add to the exam by right-clicking on a Pending 
scan and selecting Edit. Refer to Creating Customized Scans for details on how the 
scan editor is used. 

7. Continue adding pending scans to the Scan queue until you are ready to acquire images. 

 

Note 
If you want to define a new scan protocol comprising the images currently 
selected for an exam, follow the steps in Creating a New Scan Protocol. 
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Acquiring Images 

The Video Fundus Feature 

 

Note 
This feature is only available in Leica products with video fundus 
capabilities. 

 

The video fundus feature can be used to track the placement of the scan in order to better 
analyze specific locations in the eye. It is automatically recorded and saved when OCT 
images are taken. Video is captured during aiming, snapshot, and free run use. An image is 
captured at the beginning of taking a snapshot and at the start of the completion of a free run. 
The image is saved with the OCT data and will load when the OCT data is loaded at a later 
time. 

 

Figure 56: Video Fundus controls at bottom left of Fundus screen 

You can use the video fundus while the system is idle to align the placement of the scan 
manually using a live feed and snapshots: 

1. Select the Toggle video capture button (computer monitor icon) to start the live feed.  

2. To take a snapshot, select the Take snapshot of video button (camera icon) while the 
live feed is on. 

 

Note 
If the toggle video capture button is unavailable; make sure the system is 
not being used to capture an OCT image. 

 

You can make changes to the mode, brightness, contrast, and exposure. These settings are 
located under the Mode, Brightness, Contrast, and Exposure controls button (wrench).  

1. Click the Mode, Brightness, Contrast, and Exposure controls button (Figure 56). A 
dialog box with the settings will appear. 

2. To change the mode, select the drop down menu and choose from 1x (high 
resolution), 2x (standard resolution), and 4x (high speed resolution). 

3. To change the brightness, contrast, and exposure, use the sliding bars located next to 
the appropriate label, or input a specific number in the digit box.  

4. Select “OK”. 

To adjust the illumination of the fundus camera: 

1. On the handheld probe interface box, look for the Fundus Adjust knob. 

2. Turn the knob counter-clockwise to turn the illumination down, and clockwise to 
increase the illumination. 
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There is also the capability to show or hide the dynamic scan control overlay present on the 
fundus video screen: 

1. Click the Show/Hide overlay button (arrows) on the video fundus tool bar (Figure 56). 
The overlay will be displayed by default, and can be toggled off and on by clicking the 
Show/hide overlay button. 

The tool bar has some options including visibility and bar placement. These can be changed 
by using the right click menu on the video fundus screen. 

To change visibility: 

1. Right-click and select Toolbar Visible to toggle the toolbar off and on. 

To change the location of the toolbar: 

1. Right-click and select Toolbar Dock, then select either Bottom or Left. The toolbar 
will be docked against the selected edge. 

You can make a print preview, save, and print a snapshot of the video.  

To save: 

1. Click the Save icon on the toolbar. 

To preview before printing: 

1. Click the Print Preview button below the window, and the Print Preview dialog box 
opens. 

2. To change the size of the preview image, click the Zoom button and select an option. 

3. To print from the Print Preview window, click the Print button. 

To print without previewing the image,  

1. Click the Printer button under the window, and the Print dialog box opens. 

2. Select the printer to which you want to print, and adjust other settings as necessary, and 
then click the OK button. 

 

Dynamic Scan Control 

After making gross adjustments in aiming with the fundus camera, the dynamic scan control 
feature allows the user to make fine adjustments to the move the position, resize the 
dimensions, and rotate the angle of the scan. You can make adjustments while the system is 
idle, during aiming mode, and free-scan mode. You cannot make adjustments while a scan is 
being acquired. 

The user can show or hide the dynamic scan control overlay on the fundus video screen: 

1. Click the Show/Hide overlay button on the video fundus tool bar (Figure 56) to toggle 
the dynamic scan control graphic off and on. 

The dynamic scan control graphic reflects the pattern of the selected scan. If there is no scan 
selected, the graphic will default to the last executed pattern. 

There are three different overlays patterns for the five scan types including: 

1. Green Rectangular graphic (Figure 57)  

a. Rectangular volume scans 
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b. Mixed-volume scans 

2. Red Line-type graphic (Figure 58) 

a. This is displayed for Linear B-scans 

3. Blue Circular graphic (Figure 59) 

a. Radial volume scans 

b. Annular volume scans 

 

Figure 57: Rectangular overlay graphic 

 

Figure 58: Line-type overlay graphic 
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Figure 59: Circular overlay graphic 

You can change the position of the scan based on the fundus video using the overlay: 

1. Left click and hold the center of the overlay graphic (Black arrow in Figure 60). 

2. Drag the overlay to the desired area on the fundus video. 

3. Release the mouse button. This will release movement of the overlay graphic and 
make immediate adjustments to the scan so the desired area is being scanned. 

 

Figure 60: Changing the position of the overlay graphic 

You can change the angle of the scan based on the fundus video using the overlay: 

1. Left click and hold the angle marker (green tab designated by black arrow) next to the 
center marker in the overlay graphic (Figure 61). 

2. Click and drag to rotate the graphic to the desired angle.  

3. Release the mouse button. This will release movement of the overlay graphic and 
make immediate adjustments to the scan so the desired angle is achieved. 
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Figure 61: Changing the angle of the overlay graphic 

You can change the dimensions of the scan based on the fundus video using the overlay: 

1. Left click and hold a tab on the side of the overlay graphic (Figure 62). 

2. Click and drag to change the length or width to the desired size. The size will be 
updated immediately while adjusting. 

3. Release the mouse button. This will release movement and leave the scan at the 
desired size. 

 

Figure 62: Changing the dimensions of the overlay graphic 

 

Aiming to Acquire an Image 

Follow the steps below to aim the scanner and acquire the image. 

1. Click the Aim button, and the system activates two images at the top of the Imaging 
tab: the Horizontal and Vertical B-Scan alignments. These images show the horizontal 
and vertical scanning beams, enabling you to more precisely center the image on the 
feature of interest (fovea, optic nerve head, lesion, etc.) for the scan. 

2. Position the hand-held probe in front of (or over) the patient's eye.  
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3. You may either start with the lens as close to the subject’s eye as possible and move it 
outward keeping the angle constant, or alternately, you may start with the probe further 
away and move it closer to the eye to find the image.   

6. Center the image in the horizontal plane by translating the probe left or right to move 
laterally in the plane that is tangential to the eye, centering horizontally on the feature of 
interest. 

7. To center the image in the vertical plane, translate the probe up or down, centering 
vertically on the feature of interest. When you are finished aiming the scanner, the top 
of the image should be located in the top one third or one half of the Horizontal B-Scan 
window. (See sample below of a correctly aligned image.) 

You may also try some angular adjustments with the probe, always adjusting in one 
direction at a time, to ensure that the scan waist is located in the right place in the subject 
eye.  The purpose of all these adjustments is to get the brightest image. 

To sharpen the image, you may adjust the focus (Diopter setting) on the barrel of the 
human retinal bore for the brightest image.  

8. When the image is in correct alignment and sharpest focus, click the Start Snapshot 
button.  This will switch the scanner from aiming to scan acquisition mode. Now the 
Horizontal and Vertical windows display the B-Scans in real time and the volume 
intensity projection as the image is being generated. 

 

Note 
You may use the right footswitch on the foot pedal to start the snapshot.   

 

 

Note 
If InVivoVue cannot allocate sufficient memory to acquire the scan, it will 
display a message indicating memory allocation failure.  When this occurs, 
reduce the size of the scan by modifying one or more of the following scan 
parameters: lines, scan, frames, and/or volumes. 

   

9. When the scanning is complete, the Status of the scan changes from Pending to 
Unsaved and the Save button is enabled.  The time the scan was acquired is displayed 
below the scan status. If you are satisfied with the image, click the Save button, and the 
Status of the scan changes from Unsaved to Saved.  If you are not satisfied with the 
pending image, repeat the steps above. 

 

Note 
You may use the right footswitch on the foot pedal to save the scan.     
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Note 
InVivoVue checks the default save drive for sufficient space.  If there is less 
than 10% free space available on the default save drive, you will be advised 
to archive exams in order to free up space; however, you may save the 
scan.  If there is less than 2 gigabytes of free space on the default save 
drive, you will advised to archive scans and will not be allowed to save any 
more scans until there is more than 2 gigabytes of free space available to 
save a scan. 

 

10. If at any time you want to cancel the aiming process, click the Stop button. 

You can view the image in the B-Scan window using the Playback controls below the window. 
Using the slider controls for Frame, you can adjust the individual frames for viewing. 

 

Using Free Run Mode to Acquire an Image 

Free Run mode is an alternative to Aiming mode to acquire an image. Free Run mode puts the 
system in a continuous scan mode and displays the B-Scan image and any volume intensity 
projection (for Volume images) as they are being acquired. In this mode, the size of the image 
buffer is determined by the scan definition and is limited to storing one set of frames of image 
data, so you must choose carefully what you want to save. 

Follow these steps to acquire an image using Free Run mode: 

1. Click the Free Run button. The system begins to scan continuously, and the label on 
the button changes to End. 

2. Position the probe in front of, or over the subject’s eye, and make manual adjustments 
as described in the previous section, to align for a good image. 

3. Once you start Free Run, if you want to stop scanning, click the End button, and the 
scanning stops after completing the current run. Furthermore, if you click the End button, 
it changes to Abort, allowing you to cancel the scan without waiting for the run to 
complete. 

4. Be sure to align the image in the frame so that the top of the image (i.e., the tissue 
surface) is located in the top one third or one half of the Horizontal B-Scan window. 

5. When the system has acquired satisfactory frames for the image, click the End button 
to end the scanning process.  When the scanning is complete, the Status of the scan 
changes from Pending to Unsaved and the Save button is enabled.  The time the scan 
was acquired is displayed below the scan status. 

 

Note 
You may use the right footswitch on the foot pedal to stop free run mode.   
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Note 
If InVivoVue cannot allocate sufficient memory to acquire the scan, it will 
display a message indicating memory allocation failure.  When this occurs, 
reduce the size of the scan by modifying one or more of the following scan 
parameters: lines, scan, frames, and/or volumes.    

 

6. If you are satisfied with the pending image, click the Save button, and the Status of the 
scan changes from Unsaved to Saved. If you are not satisfied with the pending image, 
repeat the steps above. 

 

Note 
You may use the right footswitch on the foot pedal to save the scan.   

 

 

Note 
InVivoVue checks the default save drive for sufficient space.  If there is less 
than 10% free space available on the default save drive, you will be advised 
to archive exams in order to free up space; however, you may save the 
scan.  If there is less than 2 gigabytes of free space on the default save 
drive, you will advised to archive scans and will not be allowed to save any 
more scans until there is more than 2 gigabytes of free space available to 
save a scan. 

 

You can view the image in the B-Scan window using the Playback controls below the window. 
Using the slider controls for Frame, you can adjust the individual frames for viewing. 

 

Foot Pedal Control 

The foot pedal may be used to enable hands-free acquisition and saving of images.  It may be 
used after the Aim button is employed on the first scan in the scan list. Clicking the foot switch 
will now activate the Save option.  Once the save has occurred, clicking the foot switch once 
more starts the Aiming mode for the next scan in the scan list, and you may continue the process 
of acquisition and saving in this manner.   

 

Scan Patterns 

There are five scan patterns currently available on the Leica SDOCT system.  The following 
sections describe them with tables of parameters that are to be considered while setting up 
such scan patterns. 

 

Linear Scan (B-Scan)  

A linear scan or B-scan represents an axial slice through the tissue being imaged, and the 
apparent resolution of the image is dependent on the number of A-scans that it is composed of.  
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It is possible to acquire a series of B-scans in the same spot on a subject, and also to average 
groups of them to improve the contrast and signal-to-noise ratio.  The parameters in the table 
below describe settings that may be used.   

 

  Parameter Typical 
Setting 

Notes 

Length 0.5  – 12 mm 
Set to the desired lateral “scan length” in mm. 

 

Angle 

 

0 – 180 

Set this angle (in degrees) to control whether the 
scan occurs along the horizontal axis, the vertical 
axis, or somewhere in between. 0 is a horizontal 
scan, while 90 is vertical. 

Horizontal Offset 0 mm 
Set to change the horizontal center point of the scan 
(in mm).  The allowed range is +/- 5 mm. 

Vertical Offset 0 mm 
Set to change the vertical center point of the scan (in 
mm).  The allowed range is +/- 5 mm. 

A-scans/B-scan 200 – 5000 This axial sampling parameter determines the speed 
of the acquisition.  A typical setting may be 1000. 

B-scans 1 - 100 This represents the number of B-scans acquired in 
the same spot, which allows for one to follow 
changes over time 

Frames/B-scan 1 – 10 This parameter indicates the number of frames that 
are averaged to yield one averaged B-scan; setting it 
to 1 means no averaging can be done. 

Inactive A-scans 
/B-scan 

100 – 1024 Set to the number of lines in a frame where no data 
is taken (and no steering voltage is required).  

 

Rectangular Volume Scan 

A rectangular volume scan is a volumetric acquisition made up of a series of B-scans that are 
acquired in a raster scan pattern moving from the bottom of the volume (or the front) to the top 
(or the back).  Note that the direction of this acquisition is reversed for the 180 degree setup 
(where the parameters are set up to allow for the scanning of a subject lying supine with the 
hand-held probe being held over the subject’s eye).  As this scan is acquired, a Volume Intensity 
Projection image, which is the summed voxel projection through the displayed depth of the stack 
of B-scans, is calculated and displayed.  The parameters in the table describe settings that are 
relevant to the acquisition of a rectangular volume scan. 
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Parameter Typical 
Setting 

Notes 

(Azimuth) 
Length 

0.5 – 12 mm 
Set to the desired azimuth scan length in mm. 

(Elevation) 
Width 

0.5 – 12 mm 
Set to the desired elevation scan length in mm.  This 
is the orthogonal direction to the azimuth scan. 

Angle 0 – 360 
Set this angle (in degrees) to control whether the 
scan occurs along the horizontal axis, the vertical 
axis, or somewhere in between. 0 is horizontal, while 
90 is vertical. 

Horizontal Offset 0 mm 
Set to change the horizontal center point of the scan 
(in mm).  The allowed range is +/- 5 mm. 

Vertical Offset 0 mm 
Set to change the vertical center point of the scan (in 
mm).  The allowed range is +/- 5 mm. 

A-scans/B-scan 200 – 5000 This axial sampling parameter determines the speed 
of the acquisition.  A typical setting may be 1000.  A 
lower number allows for higher scan speed while a 
higher one results in denser axial sampling. 

B-scans 2 – 400 This parameter denotes the number of B-scans in the 
volume, and determines the elevation scan density. 
The greater the number of B-scans, the more highly 
sampled the VIP image.   

Frames/B-scan 1 – 10 When this parameter is greater than 1, it allows for 
Registration and Averaging to be performed.   

Volumes 1 - 4 This parameter allows for multiple volume 
acquisition, which may aid in achieving greater 
signal-to-noise ratio for 3D rendering.  

Inactive A-scans 
/B-scan 

100 – 1024 Set to the number of lines in a frame where no data 
is taken (and no steering voltage is required). 

 

Mixed Volume Mode 

This scan is a type of rectangular volume acquisition which has low axial sampling density 
throughout the volume, but with a high-density linear scan embedded in the center of the 
volume.  This scan type is useful when one wants a high-density averaged B-scan with 
registration information.  The relevant parameters are listed below: 

 

Parameter Typical 
Setting 

Notes 

(Azimuth) Length 0.5  – 12 mm 
Set to the desired azimuth scan length in mm. 
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(Elevation) Width 0.5 – 12 mm 
Set to the desired elevation scan length in mm.  This 
is the orthogonal direction to the azimuth scan. 

Angle 0 – 360 
Set this angle (in degrees) to control whether the 
scan occurs along the horizontal axis, the vertical 
axis, or somewhere in between. 0 is horizontal, while 
90 is vertical. 

Horizontal Offset 0 mm 
Set to change the horizontal center point of the scan 
(in mm).  The allowed range is +/- 5 mm. 

Vertical Offset 0 mm 
Set to change the vertical center point of the scan (in 
mm).  The allowed range is +/- 5 mm. 

A-scans/B-scan 200 - 400 This axial sampling parameter determines the speed 
of the volumetric acquisition.  A typical setting is 
around 200 or 250, which allows for a fast acquisition. 

B-scans/Volume 100 - 200 This parameter denotes the number of B-scans in the 
volume, which affects the elevation sampling density. 

High Density      
A-scans/B-scan 

1000 This parameter determines the axial sampling of the 
high-density B-scan located in the center of the 
volume. 

High Density      
B-scans 

1-20 This parameter indicates the number of high-density 
frames that will be averaged to yield the single high-
density B-scan in the center of the volume. 

Inactive A-scans 
/B-scan 

100 – 1024 Set to the number of lines in a frame where no data 
is taken (and no steering voltage is required). 

 

Radial Volume 

A radial scan allows for the volumetric acquisition of a subject with B-scans scanning radially 
throughout the volume.  The central portion of the field of view is sampled highly in this type of 
acquisition, while sampling is sparser toward the outer part of the volume. The parameters for 
setting up a radial scan pattern are as follows: 

 

Parameter Typical Setting Notes 

Diameter 0.5 – 12 mm 
Set to the desired diameter of radial scans in the 
volume. 

Horizontal 
Offset 

0 mm 
Set to change the horizontal center point of the scan (in 
mm).  The allowed range is +/- 5 mm. 
 

Vertical Offset 0 mm 
Set to change the vertical center point of the scan (in 
mm).  The allowed range is +/- 5 mm. 

A-scans/B-
scan 

200 – 5000 This axial sampling parameter determines the speed of 
the acquisition.  A typical setting may be 1000.  A lower 
number allows for higher scan speed while a higher 
one results in denser axial sampling. 



 Daily Workflow 
 

9054-10054 Rev E  Page 73 of 120 

B-
scans/Volume 

2 – 400 This parameter denotes the number of B-scans in the 
volume, and determines the scan density. The greater 
the number of B-scans, the more highly sampled the 
VIP image.   

Frames/B-
scan 

1 – 10 When this parameter is greater than 1, it allows for 
Registration and Averaging to be performed.   

Volumes 1 - 4 This parameter allows for multiple volume acquisition. 

Inactive A-
scans /B-scan 

100 – 1024 Set to the number of lines in a frame where no data is 
taken (and no steering voltage is required). 

 

Annular Volume 

An annular volume is a volumetric acquisition composed of a series of B-scans that are 
concentric annular rings around the region of interest.  A minimum diameter can be defined in 
addition to the ‘maximum’ diameter of the final B-scan, and this setting allows for one to 
determine the density of sampling within the annular volume.  A correction factor ensures that 
the same number of samples is present in every B-scan throughout the volume.  Relevant 
parameters are listed below: 

 

Parameter Typical Setting Notes 

Min. Diameter 0.5 – 12 mm 
Set to the desired inner diameter of the annular volume 
acquisition. 

Max. Diameter 0.5 – 12 mm 
Set this to the desired diameter of the annular volume. 

Horizontal 
Offset 

0 mm 
Set to change the horizontal center point of the scan (in 
mm).  The allowed range is +/- 5 mm. 

Vertical Offset 0 mm 
Set to change the vertical center point of the scan (in 
mm).  The allowed range is +/- 5 mm. 

A-scans/B-
scan 

200 – 5000 This axial sampling parameter determines the speed of 
the acquisition.  A typical setting may be 1000.  A lower 
number allows for higher scan speed while a higher 
one results in denser axial sampling. 

B-
scans/Volume 

2 – 400 This parameter denotes the number of B-scans in the 
volume, and determines the scan density. The greater 
the number of B-scans, the more highly sampled the 
VIP image.   

Frames/B-
scan 

1 – 10 When this parameter is greater than 1, it allows for 
Registration and Averaging to be performed.   

Volumes 1 - 4 This parameter allows for multiple volume acquisition. 

Inactive A-
scans /B-scan 

100 – 1024 Set to the number of lines in a frame where no data is 
taken (and no steering voltage is required). 
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Working with Scans 

Memory Usage 

InVivoVue displays a bar in the Select Parameters for New Scan dialog that provides feedback 
on the memory footprint of the custom scan.  This bar is updated as each of its attributes are 
edited, to reflect the cost of each choice. The memory bar is green when it is likely that there is 
sufficient memory to acquire the scan; red, when the computer system calculates that the scan 
will exceed 70% of available memory.  There is a little uncertainty, because the memory must 
not only be available, but in large enough chunks to be useful in storing frame data. 
 
Reading the System Memory bar from left to right: 

• The solid green area indicates the estimated percentage of memory in currently in use 

• The hatched area to the right of the solid green area indicates the estimated percentage 
of the remaining system memory that is needed to acquire the scan.  If there is sufficient 
system memory available to acquire the scan the hatched area is green; otherwise, the 
hatched area is red. 

In addition, InVivoVue displays textual information that corresponds to the graphical display:  

• Percentage of memory currently in use  

• Percentage of remaining memory needed to acquire the scan  

• Memory requirements of the custom scan (in MB) 

InVivoVue will allow you to add the scan to the exam, even scan if the memory bar is red.  
However, if it is insufficient at the time the scan is started, InVivoVue will notify you and suggest 
you reduce the size of the scan by modifying the lines, scans, frames and/or volume parameters. 

 
Figure 63: System memory bar and textual information. Green signifies the scan can be acquired. Red 

signifies there is not enough memory 

Creating Custom Scans 

Instead of using any of the preset scans available in your system, you may want to define your 
own parameters for scans to add to the exam. 

 

Note 
You can only add customized scans to an exam that has the current 
(today's) date. For exams dated in the past, you can only delete scans for 
which the Status is 'Abandoned;' all other functions for adding or editing 
scans are disabled. 

 

Follow these steps: 
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1. Right-click a pending scan from the Scan queue and select Edit to open the Select 
Parameters for New Scan dialog. 

 

Figure 64: Select Parameters for New Scan 

2. If you want to base your customized scan on a preset scan, select a scan from the 
Defined Scan Presets drop-down list, and click the Copy Settings from Selected 
Preset button. The parameters of the selected preset scan are then loaded into the 
Select Parameters group. 

3. If you do not want to base your customized scan on a preset scan, then click the button 
for the scan pattern (Annular Volume, Linear B-Scan, etc.) you want to acquire, and the 
default parameters for that type are loaded into the Select Parameters group. 

4. Make any changes to the parameters (Diameters, Offsets, etc.) of the scan, either by 
using the scrolling buttons to select values or by selecting the field and typing the value 
you want. 

5. Select whether you want to scan the OD (right), OS (left) or OU (both) eyes. (If you 
select OU, two scans are added to the exam, one for each eye.) 

6. If you want to acquire Doppler data along with the scan data, select the Doppler scan? 
check box and specify the Number of Samples to acquire.  This number indicates the 
number of Doppler samples that are acquired per B-scan. 

 

Note 
Leica recommends 2 to 5 samples; otherwise, the time to acquire the scan 
may be prohibitively long. 
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7. When you have finished setting the parameters for the scan, you can save the 
parameters as a new preset scan. Enter a unique name for the new preset scan, eye 
selection and click the Create Preset button. 

8. It is a good idea to observe the System Memory bar above the Add to Exam button.  
The System Memory bar will tell you when the selected scan parameters (lines, scans, 
and frames, volumes) will result in a scan that may be too large to acquire.  The System 
Memory bar is green when there is sufficient memory to acquire the scan; red, when the 
computer system may not be able to allocate enough memory to acquire the scan.  (For 
more information on the System Memory bar, see Memory Management.) 

9. Click the Add to Exam button to add the scan(s) to the exam and close the dialog box, 
or click the Cancel button to close the dialog box without adding a scan to the exam. 

If you want to add additional custom scans to the exam, repeat the steps in this topic for each 
additional scan. 

 

Editing Scans 

Preset or customized scans can be edited while their Status is Pending (you have not acquired 
an image).  Note: Scans added from a protocol cannot be edited.  To edit a preset scan, follow 
these steps:  Follow these steps: 

1. Right-click a pending scan in the Scan queue and select Edit. 

2. In the Customize Scans group box above the list, click the Edit Selected Scan... button.  
The Edit Scan Parameters dialog box will open. 

 

Figure 65: Edit Scan Presets dialog box 
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3. In the dialog box, you can select another preset scan, select a different type of scan, or 
change individual parameters including which eye(s) to scan. 

4. If you want to save your changes as a new preset scan, give it a name in the Enter Name 
for Preset field near the bottom of the dialog box. 

5. When you have completed all of your changes, click the Save Changes button at the 
bottom of the dialog box. 

 

Note 
If you find you want to change the parameters of a scan after acquiring an 
image, you can clear the image by selecting another scan or by changing 
from the Imaging tab. In the message box that appears and asks if you 
want to save the data, click the No button. Select the scan again, and follow 
the steps above. 

 

 

Deleting Scans 
You can delete scans from an exam if the Status of the scan is Pending (you have not acquired 
an image). For example, you might select a group of scans from a protocol but elect not to 
conduct one or more of them. Abandoned scans can also be deleted.  In order to delete 
abandoned scans, follow these steps: 

1. From the Scan queue, select the scan you want to delete. The selected scan is 
highlighted green. 

2. Right click on the Scan and select Delete to delete it.  

 

Saving Image Scans 

After you have acquired a satisfactory image for a scan, you can save the scan for the patient's 
current exam record. Before you save them, you can review image scans to ensure you have 
acquired satisfactory images. 

After an image has been acquired, the scan status changes to Unsaved. To save the scan, click 
the Save button. If you do NOT want to save the OCU (raw spectral data) file for an image, 
deselect Save OCU data? before saving the scan. 

 

Note 
InVivoVue checks the default save drive for sufficient space.  If there is less 
than 10% free space available on the default save drive, you will be advised 
to archive exams in order to free up space; however, you may save the 
scan.  If there is less than 2 gigabytes of free space on the default save 
drive, you will advised to archive scans and will not be allowed to save any 
more scans until there is more than 2 gigabytes of free space available to 
save a scan. 

 

For each saved scan, InVivoVue creates and stores four or five individual files (depending upon 
the file type), giving them a sequential name based on the patient ID, on which eye is scanned 
and on certain other parameters from the scan. The five file types are 

• raw spectral data of the scan, .OCU file extension 
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• processed data of the scan, .OCT file extension 

• bitmap image of frame 1 (one) of the B-Scan, .BMP extension 

• bitmap image of the fundus image, .BMP extension 

• bitmap image of the VIP window (for volume scans only), .BMP extension 

 

Note 
If you want to save a different bitmap image (other than frame 1) for the B-
Scan, you can select it by playing the B-Scan using the VCR playback 
buttons to review each frame and stopping the playback at the specific 
frame you want to save. 

 

Also, at any time while acquiring or reviewing image scans, you can save copies of images 
from the VIP and Fundus Video/Scan Control windows. For example, you might want copies 
of these images for consultation or for later review. Click the Save button below the window to 
save copies of images in either window. 

 

Loading Scans for Review 

At any time, you can review saved scans, provided they have not been archived, which removes 
them from the system. (You can review scans from archived scans only if you retrieve them 
from the archive.) You can review saved or unsaved scans from the current exam in progress, 
or you can load a previous exam.  

Follow these steps to select scans from the current exam: 

1. Locate scans for the current exam in Scan queue on the Imaging tab. 

2. If you have just completed a scan, but you have not yet saved it, you can replay this 
unsaved scan by using the Playback buttons. 

3. To review a saved scan, double-click the icon in the Scan queue. 

Follow these steps to select scans from a previous exam: 

1. On the Patient/Exam tab, select the patient record for which you want to review image 
scans. (If you need help finding a patient, refer to Selecting or Adding the Patient.) When 
you select the patient record, all exams for that patient are loaded into the list in the 
Patient Exams group box on the right. 

2. From the list of patient exams, select the exam for which you want to review scans, and 
click the Review Exam button. If the selected exam is for the current date and is 
incomplete, the Review Exam button is instead labeled Continue Exam or Start Exam. 
InVivoVue switches to the Imaging tab, and the scans for the selected exam are listed 
in the Scan queue at the bottom. 

3. To review a saved scan, double-click the icon in the Scan queue. 

After you select the saved scan to review, follow these steps: 

1. Replay the image by using the Playback buttons. 

2. To adjust the brightness or contrast during playback, right-click in the B-scan display 
area and select Display Options to open the Edit Display Options dialog. 
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Figure 66: Edit Display Options 

3. On the Adjustments tab, use the slider controls for Brightness and Contrast to 
increase or decrease these settings. Click the Reset button to restore these settings to 
the levels of the image as first captured. 

4. To view the scan details contained in the OCT header, double-click the file name that is 
displayed above the Volume Intensity Projection window. 

 

Playing Back Image Scans 

For image playback, several controls are available to stop and start playback, to select and few 
frames individually or play them in succession and to adjust the rate of playback. 

The primary playback controls are modeled after those of a video or music player: 

 Displays the first frame of the scan 

 Moves backward to the previous frame 

 Plays all frames in succession, looping through the scan repeatedly until another 
button is clicked 

 Stops playback 

 Moves forward to the next frame 

 Displays the last frame of the scan 

Two slider controls, which you can drag with the mouse, allow you to set the rate of playback 
and to select individual frames: 

Rate allows you to select the number of frames per second for playback, and the numeric 
value shows the current selected rate. 

Frame allows you to select individual frames in the sequence, and the numeric value 
shows the number of the current frame of the total number of frames. 
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Figure 67: Slider controls for Rate and Frame 

 

Changing B-Scan Window Settings 

You can make several adjustments for the B-Scan window to alter or improve the display of 
images. You can adjust brightness and contrast, display Doppler and change its settings, select 
beginning and ending line samples to eliminate insignificant parts of the image and change the 
type and color map of the display. 

Follow these steps to adjust these settings: 

1. Right-click in the B-Scan window and select Display Options… to open the Edit 
Display Options window. 

2. Select the Adjustments tab (Figure 66). 

a. Use the slider controls to adjust the Brightness and Contrast of the image in 
the B-Scan window. Note that the image responds while you make adjustments. 

b. If you are viewing Doppler data, click the check box Display Doppler, and then 
use the slider controls to adjust Scaling, OCT and Doppler Level Threshold and 
Transparency. 

c. Click the Reset button in either group box to restore the original settings in that 
group. 

3. Select the Options tab. Controls in the Custom Range group box allow you to narrow 
the number of line samples to view, to magnify or focus in on a particular area along the 
vertical dimension of the image. 

a. Click the Custom Sample Range check box to adjust the number of line 
samples to view. 

b. Slide the Start control from left to right to exclude line samples from the top. 

c. Slide the End control from right to left to include or exclude line samples from 
the bottom of the image. 

d. Click the Reset button to restore the default settings for the image. 

e. Click the Invert check box to flip the image along its horizontal axis. 
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Figure 68: Edit Display Options with Options tab selected 

4. In the Display Type group box, select Frame to see the entire B-Scan image, or select 
Line to display individual line samples from the image. Click and drag the slider control, 
or click on the arrow buttons at either end, to display the individual lines. If you click and 
hold an arrow button, lines are displayed in rapid succession throughout the image. 

5. In the Display Color Map group box, select the option buttons to view the image in 
Grayscale or Color. 

 

Setting VIP Window Samples 

The en face image for volume scans is displayed in the Volume Intensity Projection (VIP) 
window. By default, this image is produced by projecting or summing the image intensities 
through the entire range of depth as displayed in the B-Scan window. However, you can change 
the settings to sum through a narrower range at any chosen depth of scan. To change the 
sample summation range, you use the Windowing Lines in the B-Scan. 

To display the Windowing Lines, right-click on the B-Scan window and select Windowing 
Display On. A triplet of horizontal lines is displayed on the B-scan window.  The center line 
indicates the window center and the upper and lower lines indicate the sample width. These 
lines can be dragged to adjust the range of line samples used to generate the VIP image. 

 

Working with Patients and Exams 

The Imaging tab contains some buttons that make it more convenient to make changes to 
patients and exams while conducting an exam.  These buttons appear at the top left, below 
the tabs themselves and above everything else. Although the buttons have no associated text, 
hovering the mouse above the buttons will yield a tooltip describing each button’s default 
function.. 

 

Figure 69: Patient and Exam buttons 

The split button located in the patient information section allows changes to the Patient 
information. The first action located in the split button drop down menu is to Edit Patient 
Details.  It serves the same function as the Edit Patient button on the Patient/Exam tab: 
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clicking it brings up the Edit Patient dialog.  This is one way users can assign an actual 
identity to an anonymous patient. 

The Associate Patient action allows the user to associate a patient’s exams with a different 
patient.  This will be used commonly after completing an exam on an anonymous patient, to 
designate that the exam data belongs to an already-known patient. Clicking it will bring up the 
Associate exam with selected patient dialog, pictured below.  Select the name of the 
patient with whom the exam should be associated, and click OK. 

 

Figure 70: Associate Exam dialog 

When an anonymous patient’s is identified, the entry for him will disappear from the patient list 
on the Patient/Exam tab. When that known patient is selected, the formerly-anonymous 
exams will appear in his list. 

The third action is New Anonymous Patient. When several patients are examined in a row, 
the program is unable to tell, without help, where one exam stops and the next begins.  Click 
this button to add a new anonymous patient, and a new (empty) exam is generated by default.  
Of course, it is always possible to visit the Patient/Exam tab and select a known patient from 
the list there. 

The split button located in the exam information section allows changes to the exam’s 
information. Clicking the button will select the default action and open the Edit Exam dialog 
box.  This action is also located first on the drop down menu for the split button. The second 
action is Add Exam. It serves the same function as the Add Exam button on the 
Patient/Exam tab: clicking it starts a new, empty exam for the selected patient. The third 
action is Copy Exam. This action will create and open a copy of the current exam. The final 
action is Copy Exam (Other Eye). This action will create and open a copy of the current 
exam but change all the scans to the opposite eye selection.  
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Printing Images 

InVivoVue allows you to print images through the File menu Print option (Figure 71), as well as 
to preview them before printing, in a couple of ways. You can preview and print single images 
of the B-Scan, Volume Intensity Projection and Video Fundus/Scan Control windows. Select 
from the following sections for instructions about the window you want to print. 

 

Figure 71: Print Menu 

The B-Scan Window 

Before printing from the B-Scan window, select the frame you want to print. Follow these steps: 

1. To select a frame for previewing and printing, click the Frame Advance button repeatedly 
until the frame you want to print is loaded in the window. Optionally, you can drag the 
Frame slider control to select a frame. 

2. Under the File menu, select Print Preview to open the Print Preview dialog. You have 
a choice of previewing a B-scan image or the volume image. 

 

Figure 72: Print preview 

3. To change the size of the preview image, click the Zoom button and select an option. 

4. To print from the Print Preview window, click the Print button. 
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5. To print without previewing the image, select Print | B-Scan Image from the File menu.  
The Print dialog box will open. 

6. Select the printer to which you want to print, and adjust other settings as necessary, and 
then click the OK button. 

 

The Volume Intensity Projection Window 

1. To preview before printing, click the Print Preview button below the window, and the 
Print Preview dialog box opens (Figure 72). 

2. To change the size of the preview image, click the Zoom button and select an option. 

3. To print from the Print Preview window, click the Print button. 

4. To print without previewing the image, click the Printer button under the window, and the 
Print dialog box opens. (Alternatively, select Print Volume Image from the File menu to 
open the Print dialog box.) 

5. Select the printer to which you want to print, and adjust other settings as necessary, and 
then click the OK button. 

 

Shutting Down the Envisu 

About Shutting Down the Envisu 

Leica recommends that you shut down the system at the end of each day.  Before you shut 
down the Envisu, it is a good time to consider Exporting or Archiving patient exams.   

 

Shutting off the Power 

Once you have completed all activity for the day, first shut down the computer using the normal 
means.  Then when the computer has completed its shutdown sequence, then turn off the 
master power switch on the Uninterruptible Power Supply (UPS). This will power down the 
imaging engine and probe interface box.  
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Advanced Software Operations 
 

Doppler Mode 

Acquiring Doppler Data 

InVivoVue allows you to acquire Doppler data for images, which comes in the form of multiple 
lines of information for each A-Scan. Doppler data is then overlaid on the B-Scan image as it is 
displayed. If you decide to acquire Doppler data, first consider whether the parameters of your 
scan will leave sufficient additional memory for this data.  The amount of memory used scales 
with the number of A-scans x (1 + the number of Doppler lines).  The System Memory bar and 
Scan Memory Requirements provide feedback on available system memory and scan size. 

Follow these steps to acquire Doppler data on a custom scan: 

1. From the Imaging tab, right-click a pending scan and select Edit to open the scan editor. 
(Figure 42). 

2. Select a scan pattern and set the scan parameters (dimension, angle, lines, scans, 
frames, etc.) and the eye selection. 

3. Check the Doppler scan? box and set the number of Doppler intervals you want to 
acquire per A-Scan in the Number of Intervals text box.  Leica recommends setting the 
Number of Doppler Intervals to no more than 5. 

4. Note the System Memory bar located below the Eye Selection group box. 

• If it is green, there is likely to be sufficient system memory to acquire the scan. Add 
the scan to the exam. 

• If it shows some red, the scan may be too large to acquire.  You may add the scan 
to the exam; however, when you attempt to acquire the scan, the amount of system 
memory available for allocation may be insufficient, in which case, InVivoVue will 
not will not be able acquire the scan.  If this occurs, InVivoVue will display a message 
box advising that you reduce the size of the scan. 

5. Close the scan editor by selecting Save Changes. You are now ready to acquire the 
scan.  (Refer to Acquiring Images to learn more about acquiring a scan.) 

Displaying Scan with Doppler Data 

InVivoVue displays Doppler data when a scan has acquired it, provided the Display Doppler 
option has been selected. Doppler data is displayed in the B-scan window along with the OCT 
image.  A Doppler signal scale indicating the intensity of the Doppler signal is displayed on the 
right side of the B-scan window.   

The direction of blood flow is assigned the color red or blue, indicating flow away from or towards 
the transducer.   

You can adjust the display of the Doppler data by changing the scaling, transparency, and 
threshold for OCT and Doppler data.  You can turn off the Doppler display or reset the Doppler 
display settings to their original values. 

Follow these steps to adjust the Doppler data display in the B-scan window: 
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1. From the Imaging tab, load a scan that has acquired Doppler data.  (Refer to the 
information in Acquiring Doppler Data to learn how to acquire Doppler data along with 
the scan.) 

2. Right click on the B-Scan window, select Display Options and the Edit Display 
Options dialog box opens.   

3. Click the Adjustments tab. 

4. Verify that the Display Doppler check box is selected.  De-select the check box if you 
wish to turn off the Doppler display. 

5. In the main window, use the Playback buttons to view the scan.  Allow the scan to play 
continuously while adjusting the Doppler display (Figure 40). 

6. Use the Doppler Scaling slider to adjust the signal scaling, intensifying or diminishing 
the Doppler display.   

7. Use the OCT Level Threshold slider to set the threshold of OCT data that must be 
present in order to display Doppler data.  This adjustment is used to suppress Doppler 
noise on a B-scan.  It controls where you see Doppler and requires the OCT data level 
to be above the percentage of the maximum level in order for the Doppler data to be 
displayed. 

8. Use the Doppler Level Threshold slider to set the threshold for the Doppler signal.  
This adjustment requires the Doppler level to be above the threshold in order to display 
Doppler data. 

9. Use the Doppler Transparency slider to set the relative transparency of the OCT and 
Doppler signals so that both OCT and Doppler data may be seen, depending on the 
transparency setting and the relative values of each.   

10. Click on Reset button in the Doppler Adjustments group box if you wish to set the 
Doppler adjustments to their original default values. 

11. Close the dialog box. 
 

Processing Control 

Optimizing Image Dispersion 

InVivoVue contains an algorithm for optimizing the dispersion of an image. By applying this 
algorithm, you can sharpen the image significantly. Note that before optimizing you must first 
ensure that the reference arm is in the right place. 

You can optimize an image that you just acquired (which is thus in the playback buffer), or you 
can load the .OCU file (which contains the raw spectral data for an image) of another image to 
optimize. Once you have selected the image to work with, follow these steps: 

1. Ensure that the B-Scan window displays a frame with the features you want to view. You 
can either pause at that frame during playback, or you can use the Frame slider control 
to select the frame. 

2. Ensure that the retinal image fills the entire display. (If a significant amount of dark space 
exists at the top or the bottom of the image, you can alter the display options to eliminate 
those dark areas.) 
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3. From the Tools menu, select Configure Processing..., and the Image Processing and 
Resampling Controls dialog box opens. 

 

Figure 73: Image Processing and Resampling Controls on the Resampling tab 

4. Select the Resampling tab, and then click the Optimize Frame button. The number of 
the frame you selected above is displayed on the button. 

5. Press the Reprocess Now button.  

6. Optionally, as the image is played back (and reprocessed using the displayed Dispersion 
Constants), you can click the Optimize button when the frame you are most interested 
is displayed in the B-Scan window. 

7. After the process of optimization is complete, you must click the Reprocess Now button 
again to ensure that the new Dispersion Constants are applied to all the frames 
preceding the one selected above. 

 

Line / Frame Averaging 

Some degree of averaging may be performed on an acquired image when registration may not 
be a necessity.  The software provides options to do ‘line averaging’, which is a moving window 
average that averages groups of consecutive A-scans, and ‘frame averaging’, which averages 
groups of consecutive B-scans or frames.   

This option may be found by selecting the Configure Processing option from the Tools menu, 
which brings up the Image Processing and Resampling Controls dialog box (Figure 73).  In the 
center of the box is a section labeled Filtering.  There is a checkbox for Line Filter with space 
to add the number of consecutive lines to process.   

To apply the line or frame averaging option to a selected dataset, load in the .OCU file either 
from the scan list (by right-clicking the file icon next to the scan and selecting the Load OCU 
data option).  Next, select the Line or Frame Averaging option as described above by checking 
the appropriate boxes and entering the values.  Click on the Reprocess Now button in the 
Configure Processing window (Figure 73) to apply the processing option to the data. If you 
would like to view the original data, you may uncheck the options and click Reprocess Now. 

 

Tip:  It is a good idea to note the processing options used in the filename. 
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On-Screen Measurement Tools 

Calipers 

You can use calipers on an acquired image to measure layer thicknesses of various layers seen 
in the B-scan, or distances between features visible in the projection.   

The refractive index setting is an important consideration while using calipers, as it affects the 
thickness measurement.  Verify that the refractive index is set correctly by clicking on the Tools 
menu, selecting the Configure Processing option, checking the Apply Refractive Index box 
and typing in the refractive index you would like applied to the dataset.   

Calipers can be overlaid on any image that is loaded into the Imaging tab page for viewing.   

1. As a first step, make sure that the image you want to make measurements on has 
been loaded from the scan list.   

2. Scroll to the (B-scan) frame of interest, right-click and select Configure Calipers 
to access the B-Scan and VIP caliper tabs.  You may provide long and short 
names, specify angle lock, and select colors, before applying and/or saving the 
configuration.  Calipers of various types may be overlaid on the image, up to a total 
of 10. 

 

Figure 74: Configure Calipers dialog box 

   

3. Right-click the B-Scan or VIP window, move mouse over Calipers and select the 
caliper to be added. You may move the calipers onto the image by clicking on the 
center point and dragging them over. 
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Figure 75: Adding calipers to the B-scan display 

   

4. Resizing is done by grabbing the outer corners and dragging them to the desired 
length.   

 

 

Figure 76: Using the calipers 

 

5. Right-click the B-scan display window.  Select Configure Calipers (Figure 74) and 
enable/disable Display Caliper Length or Display Caliper Location in the B-
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Scan or VIP caliper tab to apply the information to be displayed in the 
corresponding window.  Note that the green line on the Volume Intensity Projection 
image now displays the calipers on it as colored lines overlaid on the green line. 

6. The caliper data can be exported to a CSV file by right-clicking the B-scan display 
window and selecting Save Calipers, automatically creating and placing the file in 
the image data folder. 

7. A bitmap of the B-scan may be saved by clicking on the File menu, selecting the 
Save As… option, choosing the BMP files option from the dropdown menu, typing 
in a filename and clicking Save. An image of the VIP with calipers may be saved 
by using the Save icon below the displayed VIP. 

 

Post-Processing 

Registration and Averaging 

The software has an option to allow for the registration and averaging of frames within a B-scan 
or volume.  This mode is enabled by the acquisition of a scan with more than one frame/B-scan.   

The first step is acquiring a scan with multiple frames/B-scan.  This is accomplished by clicking 
on the Add a Custom Scan button in the Imaging tab page, and increasing the number of 
frames/B-scan to greater than 1. Choose the number of frames you would like averaged to create 
each B-scan, and enter the number in the box.  This option may be selected for any scan pattern, 
including the B-scan.   

Once you have acquired a scan with more than one frame/B-scan, you have the option of running 
the registration and averaging the algorithm before and after saving using the Average right click 
context menu on the Scan in the Scan queue.  Be aware that the process will take time.  

Once registration and averaging has taken place, a new file with the processed data is saved, 
and can be accessed through the context menu by right clicking the scan tile. The context menu 
contains a new option to Load R&A data..  

Generating Reports 

For any saved scan, you can generate 3 different reports that contain information from the 
patient record and copies of images from the scan. The information includes the patient's name, 
age, medical record number, notes associated with the exam, exam date, print date, and the 
eye that is scanned. For the scan image, the report contains the scan type and parameters, the 
selected B-scan frame and the volume intensity projection (for volume images).  
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Figure 77: Example of Basic report 

 

Figure 78: Example of Multi-Frame report 
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Figure 79: Example of Calipers report 

 
The report is generated in Microsoft Word which is included on your Envisu computer. To 
save a patient report, first select the patient and the exam for which you want to generate a 
report, and follow these steps: 

1. On the Imaging tab, right-click a saved scan and select Load OCT data. 

2. Play back the OCT image stopping on the frame to be included in the report. 

3. To generate a report, navigate to the Reports tab above the B-scan display. Choose 
from the three available report types by clicking its associated Create… button. 
InVivoVue creates a Microsoft Word or Excel document containing the report, which is 
saved in a Reports subfolder located with the data. 

 

Figure 80: Creating a report 

4. Alternatively, you may use the Reports menu to create the type of report desired. 
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Figure 81: Alternative method for creating a report 

  

Report files are named in a manner similar to the data files for the scan. The file name is a string 
of numbers and letters that begins with the patient ID and includes references to the eye that is 
scanned, the scan type, the scan dimensions and angle, the B-scan frame number, plus a 
random, sequential number to ensure the uniqueness of the file name. 

If InVivoVue  is not able to generate a VIP bitmap due to insufficient available memory, the 
report displays ‘No volume bitmap saved – image too large for memory’. 

You may modify the report template (SimpleReport.dot) and move or resize the VIP and/or OCT 
image placeholders.  To do this, First open MS Word, and then open the simpleReport.dot file 
(located at C:\ProgramData\Bioptigen\InVivoVue\ReportTemplates) to make modifications to 
the report template.  It is a good idea to make a copy of the report template prior to modification. 

Viewing the 3-Dimensional Rendering of Image Scans 

About the 3-D Analysis Tool 

You can view a 3-dimensional (3-D) rendering of a rectangular volume scan by loading a 
rectangular volume scan into the 3-D analysis tool. The 3-D View displays four windows.  The 
main window, labeled 3D, displays a high resolution 3-D rendering of the rectangular volume 
scan.  The three smaller windows display 2-D renderings of the scan.  The three smaller 
windows are used for slicing and/or cropping the scan along the axial, coronal, and sagittal 
planes. 

While working with the 3-D image, you have access to a full set of tools you can use to  
manipulate (rotate and/or tilt) the image, render the image in high or medium resolution, crop 
and/or slice the image along various planes, register the B-scans and custom your default 
settings for the 3-D analysis tool.    

To start working with the 3-D analysis tool, you will need to load a saved rectangular volume 
scan. 

 

Loading a Rectangular Volume Scan into the 3-D Analysis Tool 

Follow these steps to load a rectangular volume scan into the 3-D analysis tool: 

1. Navigate to the Imaging tab.  From an exam scan list on the Imaging tab, load a 
rectangular volume .OCT file.  

2. Click on Tools then View 3D Volume…  

3. InVivoVue begins loading the (full and unregistered .OCT file into the 3-D analysis tool.  
A progress bar below the large 3D window tracks the progress of rendering the .OCT 
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data into a 3-D image.  To the right of the progress bar is text that indicates the name of 
the process the 3-D tool is performing as it completes the load.  When the 3-D tool has 
completed the rendering of the 3-D image, the progress bar is cleared and the text is set 
to ‘Done’.  

 

Figure 82: .OCT data loaded into 3D analysis tool 

4. Place the mouse cursor in the main 3-D window.   

a. Left-click anywhere in that area and drag the mouse to view the 3-D image from 
different angles.   

b. Right-click anywhere in that area and drag the mouse to move the 3-D image up 
or down, or to the right or left.    

c. Use the mouse wheel to zoom in and out of the 3-D image. 

 

Cropping 3-D Image to Displayed Samples 

When an .OCT file is loaded into the 3-D analysis tool, the .OCT file is loaded in its entirety then 
cropped. That is, the .OCT file is automatically cropped to the displayed line samples as defined 
on the Options tab of the Display Options dialog box, as it is in the B-Scan window.  (Refer to 
Changing B-Scan Window Settings for more information on the display options.)   

You can restore the sample to its original size and crop to a custom size: 

1. Right click on the window and select Crop → Restore Original Uncropped Image Data 

a. This will return the 3D data to the original state before it is cropped to the 
displayed samples. 

You can return the image to its original cropped state after manipulation: 

1. Right click and select Crop. 

2. Select Default Crop. 

a. This will return the 3D image to the original cropped image. 
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Registering B-Scans in 3-D Image 

When an .OCT file is loaded into the 3-D analysis tool, the B-scans in the .OCT file are not 
automatically registered to correct for eye movement, for example.  Once the rectangular 
volume scan is rendered in the 3-D analysis tool, you may want to refine the image by registering 
the B-scans. 

Follow these steps to register the B-scans in the .OCT file and re-render the 3-D image: 

1. Load a rectangular volume scan into the 3-D analysis tool (see topic, Loading a 
Rectangular Volume Scan into the 3-D Analysis Tool). 

2. Right click on screen and select Registration→ Register b-scans. InVivoVue begins 
registering the B-scans in the .OCT file. A progress bar below the large 3D window 
tracks the progress of registering the B-scans and re-rendering the .OCT data.  To the 
right of the progress bar is text that indicates the name of the process the 3-D tool is 
performing as it completes the registration request.  When the 3-D tool has completed 
registration and re-rendering of the 3-D image, the progress bar is cleared and the text 
is set to ‘Done’. 

 

Figure 83: Registering B-scans in 3D image 

  

3. Place the mouse cursor in the main 3-D window.   

a. Left-click anywhere in that area and drag the mouse to view the 3-D image from 
different angles.   

b. Right-click anywhere in that area and drag the mouse to move the 3-D image up 
or down, or to the right or left.    

c. Use the mouse wheel to zoom in and out of the 3-D image. 

4. To restore the image to its pre-registered state, hold the mouse still and right-click to 
display the mouse menu.  Select the Registration→ Restore Original Data Image option.  
(Or, you may restore the image to its pre-registered state by re-loading the rectangular 
volume scan into the 3-D view (by clicking the Load Rectangular Volume button). 
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Changing 3-D Display Options 

You may change the display options in the 3-D analysis tool by placing the mouse cursor over 
any of the 4 windows that make up the 3-D viewing area.  Hold the mouse very still and right-
click to access the mouse menu.  You may change the following display options: 

• Color Map: To change the color map, select the Show Color Map mouse menu option.  
The Color Map dialog box opens.  Select a color map from the drop down list of color 
maps on the bottom right side of the dialog box.  The color map you chose will persist 
across active sessions of InVivoVue until you select a different color map.  Close the Color 
Map dialog box. 

• View Options:  To change the View options, select the View Options mouse menu.  There 
are several viewing options you may change: 

o Black background: White is the default color of the 3-D image background.  To 
change the background to black, select Black Background.  The background color 
you choose (white or black) will persist across active sessions of InVivoVue until 
you change it. 

o High Quality 3-D (slower): The High Quality 3-D option is a default setting.  When 
set, the 3-D Analysis tool produces a high resolution image when the .OCT file is 
loaded into the 3-D Analysis tool and when the image is still.  Producing a high 
resolution image slows down the rendering.  If you don’t want a high resolution 
image you can de-select this option.  Whichever you chose, the setting will persist 
across active sessions of InVivoVue until you change it. 

o Adaptive Rendering (faster): The Adaptive Rendering option is a default setting.  
When set, the 3-D Analysis tool uses a low resolution copy of the image for faster 
rendering while the image is being moved.  If you don’t want faster rendering as 
the image is moved you can de-select this option.  Whichever you chose, the 
setting will persist across active sessions of InVivoVue until you change it. 

o Show Floor: The Show Floor is a default setting. When set, the 3-D Analysis tool 
displays a grid below the 3-D image.  Showing the floor improves image 
orientation. If you don’t want to see the floor you can de-select this option.  
Whichever you chose, the setting will persist across active sessions of InVivoVue 
until you change it. 

o Flip A-scan Axis: This Flip A-Scan Axis setting will flip the image along the A-scan 
axis.  This setting does not persist across InVivoVue sessions. 

o Stretch A-Scan: Use this feature to stretch the 3-D image in increments of 100 up 
to 800%.  This setting does not persist across InVivoVue sessions. 
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Figure 84: View Options 

 

Cropping the 3-D Image Using Crop Lines 

In addition to cropping the 3-D image to displayed samples, you may also crop or slice the 3-D 
image along the axial, coronal and sagittal planes.   

Follow these steps to crop the image along the axial, coronal and/or sagittal planes: 

1. Load a rectangular volume scan into the 3-D analysis tool (see topic, Loading a 
Rectangular Volume Scan into the 3-D Analysis Tool). 

2. Place the mouse cursor over the main 3-D window or over one of the smaller windows.  
Hold the mouse still and right click to display the mouse menu. 

3. Select Crop→Show Crop Lines.  Dashed lines are displayed along the adjustable edges 
of the image in each of the 3 smaller windows.  

 

Figure 85: Cropping the 3D image 

4. Working in Axial, Coronal or Sagittal window, place the mouse cursor on one of the 
dashed lines and move the line in (if in Axial or Sagittal window) or up or down (if in 
Coronal window).  Notice how the image is changed in the large 3D window.   
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5. To set the 3-D image to the cropped image that is displayed in the 3-D window, right-
click to display the mouse menu.  Select Crop→Crop Image (Figure 85). 

6. The 3-D image is now cropped based on the position of the crop lines within the Axial, 
Coronal and Sagittal windows. 

7. To restore the image to its pre-cropped state, hold the mouse still and right-click to 
display the mouse menu.  Select the Crop→ Restore Original Data Image option.  (Or, 
you may restore the image to its pre-registered state by re-loading the rectangular 
volume scan into the 3-D view (by clicking the Load Rectangular Volume button). 

 

Slicing the 3-D Image Using Slider Controls 

You may slice through the 3-D image along the axial, coronal and sagittal planes.   

Follow these steps to display a slice the 3-D image: 

1. Load a rectangular volume scan into the 3-D analysis tool (see topic, Loading a 
Rectangular Volume Scan into the 3-D Analysis Tool). 

2. Axial Slice: Position the mouse cursor on the slider control beside the 2-D Axial window 
and move the slider control in either up or down direction.  As you move the slider 
control, the 3-D analysis tool slices through the series of B-scans; each slice 
representing a single B-scan.  

3. Coronal Slice: Position the mouse cursor on the slider control beside the 2-D Coronal 
window and move the slider control in either up or down direction.  As you move the 
slider control, the 3-D analysis tool slices through a collection of A-scans along the 
coronal plane of the rectangular volume.   

4. Sagittal Slice: Position the mouse cursor on the slider control beside the 2-D Sagittal 
window and move the slider control in either up or down direction.  As you move the 
slider control, the 3-D analysis tool slices through a collection of A-scans along the 
sagittal plane of the rectangular volume.   

 

Capturing the 3-D Image 

At any point you may save the 3-D image (or any of the three 2-D images) as a .JPEG file (or 
as a portable bitmap or “.PBM” file).   Capturing an image in the 3D analysis tool does not alter 
the.OCT file. 

Follow these steps to save the 3-D image as a .jpeg file (or as a .PBM file): 

1. Load a rectangular volume scan into the 3-D analysis tool (see topic, Loading a 
Rectangular Volume Scan into the 3-D Analysis Tool). 

2. Place the mouse cursor over the main 3-D window or over one of the 2-D windows.  Hold 
the mouse still and right click to display the mouse menu. 

3. Select Capture→Capture Image (3D) and the Save As dialog box opens. 
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Figure 86: Capturing a 3D image 

4. Specify where to save the file. 

5. In the File name field, enter a name for the file.  

6. Select the Save as type (either .JPEG or .PBM). 

7. Click Save to save the image and close the dialog box. 

 

Resetting the 3-D Image 

There are several ways to reset the 3-D image to its original state.    

• Re-load the rectangular volume scan into the 3-D analysis tool (see topic, Loading a 
Rectangular Volume Scan into the 3-D Analysis Tool). 

• Hold the mouse still and right-click to display the mouse menu.  Select one of the 
following options: 

o Reset 3D View  

o Crop→ Restore Original Data Image 

o Register→Restore Original Data Image 

 

Switching 2-D Windows into Main Window 

You may want to view an image in one of the small 2-D windows in the larger main window.   

Follow these steps to view a 2-D image in the main window: 

1. Load a rectangular volume scan into the 3-D analysis tool (see topic, Loading a 
Rectangular Volume Scan into the 3-D Analysis Tool). 

2. Click on the label of the 2-D window that contains the image you want to view in the 
main window.  For example, if you want to move the 2-D image in the Axial window to 
the main window, click on the button labeled Axial. 
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3. The Axial window is moved to the main window and the 3-D image is moved from the 
main window to the space vacated by the Axial window.  The Axial image remains a 2-
D image. 

 

Figure 87: Viewing the Axial window 

4. Click on the label 3D, to move the 3-D image back to the main window. 

 

Acquiring and Processing Fundus Images 

To generate a high quality fundus image from a time lapse stack of individual fundus images, 
use the following protocol.  

 

1.  First, disable the camera within IVV software. This can be done within the same menu 
used in the previous section; press the following button to disable the camera. 

 
Figure 88: Disable fundus camera. 

2. Next, open IC Capture 2.2 software (shortcut is on the computer desktop).  
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3. Next, there are two windows which must be opened, (1) Sequence Settings, and (2) 
Sequence Timer. These can be opened from the Capture menu, and should be 
opened in that order. 

 
Figure 89: Sequence Settings and Sequence Timer. 

4. There are four tabs within the Sequence Settings: Filename and Target, File Type, 
Miscellaneous, and Automated Sequence. What follows are screen captures of these 
tabs with each field populated with the correct values to ensure your settings are 
appropriate. 

5. Press the “Change” button and create a new directory where the fundus image frames 
will be stored. Set Filename prefix to “Image” and Index to 100. Save each new 
sequence into a different folder to avoid confusion or mingling of data sets. This will 
capture 100 frames for averaging. If you wish to acquire greater than 999 frames, set 
the Index to 1000.  

 
Figure 90: Sequence Settings target directory. 

6. Ensure Image file type is BMP. 
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Figure 91: Sequence Settings file type. 

 
Figure 92: Sequence Settings miscellaneous settings. 

7. Set the interval Minutes and Seconds both to 0. Also, ensure that the sequence ends 
after 100 Frames. This will capture 100 frames in the sequence; if you wish to acquire 
and average more or fewer frames, adjust this value.  

 
Figure 93: Sequence Settings automated sequence settings. 

8. After all four tabs have been set to the values seen above, press OK and open the 
Sequence Timer. 

9. To begin recording from the fundus camera, press “Start Timer”. Frames will be stored 
in the target directory. 
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Figure 94: Sequence Timer. 

10. After images have been acquired and stored in the target directory, open ImageJ and 
drag the folder containing the image sequence into the ImageJ window. This will allow 
the images to be opened as a single stack. 

 
Figure 95: ImageJ drag and drop. 

 

11. Answer “Yes” to the resulting dialog box: 



InVivoVue (Release 2.4) 

Page 104 of 120  9054-10054 Rev E 

 
Figure 96: ImageJ open as stack. 

12. To convert the stack to a single, processed fundus image, navigate to the Fundus 
Video Filter plugin from the Plugins>Bioptigen menu: 

 
Figure 97: Running the Fundus Video Filter. 

13. This plugin will take < 1 min to register and average all 100 fundus images, resulting in 
a final 2D color fundus image. This can be saved as an uncompressed TIFF (or 
several other formats, JPG, GIF, PNG, etc.) by following “File>Save As>Tiff”. 
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Troubleshooting 

Resolving Software Problems 

This topic describes several software problems and suggests ways to correct them. For some 
symptoms, an advanced level of training is required for the necessary actions to resolve the 
problems. 

 

If you have this problem . . .  Try this . . . 

The scan image appears dim. Check the line spectrum and optimize it; the 
reference arm power may be too low.   

The scan image appears blurred. Optimize dispersion settings to sharpen the 
image. If this does not resolve the problem, 
change the focus and check to see if the 
reference arm position is off. 

The depth seems inadequate. Change the image display scale in the 
application window.  If this does not resolve 
the issue, adjust the path length of the 
reference arm. 

Part of the scan image is not visible, 
or the image fades at the beginning 
or end of the scan. 

Expand the horizontal and vertical offset 
parameters that are associated with the 
scan. 

"Ghost" images appear in the 
display. 

Change the path length of the reference 
arm. 

No image appears in the display. Move the sample to see if an image comes 
into focus. If this does not resolve the 
problem, telephone Leica customer support. 

The image is distorted or 'garbled.' Move the sample to see if an image comes 
into focus.  If this does not resolve the 
problem, optimize the line spectrum. 

There is background noise Work with the Brightness and Contrast 
settings in the Display dialog.  If the problem 
persists, please contact Leica Customer 
Support.  

The scan image is either too small or 
too large. 

Change the image display scale.  
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If you have this problem . . .  Try this . . . 

The scan image oscillates 
abnormally. 

Close InVivoVue, and restart it. If this does 
not resolve the problem, contact Leica 
customer support. 

Vertical striations appear in the scan 
image. 

Check the line spectrum and optimize the 
height.   

Horizontal striations appear in the 
scan image. 

Check the DC Removal option and set it to 
Auto or Manual. 

 

Checking the Line Spectrum 

Checking and adjusting the line spectrum allows for optimization of the quality of images 
acquired by the system. Possible problems that could occur when the spectrum is not optimized 
include: a dim image, distorted or ‘garbled’ images, background noise, and vertical striations in 
the scan image.  

To check the line spectrum, follow these steps: 

1. Make sure that the “Test Patient” is selected (if not create a new patient with generic 

information), and select or add an exam with today’s date. Click the Start Exam (or 

Review Exam) button, and the Imaging tab is displayed. 

2. From the Tools menu, select Load Settings..., and the Load Settings File dialog is 
displayed. 

3. Navigate to the C:\ProgramData\Bioptigen\InVivoVue\Config directory.  From the list of 
files in the dialog box, select the file Line_Spectrum.INI, and click the Open button. The 
settings for checking the line spectrum are loaded into InVivoVue. 

Note: If you do not find the LineSpectrum.INI file, refer to the procedure Creating a Line 
Spectrum Configuration File to create the file. Then load the file as described above, 
and continue with the following steps. 

4. Create a linear scan 1000x10x1, and add it to the scan list. 

5. In the middle of the Imaging tab, click the Free Run button, and a green curved line 
appears in the Horizontal B-Scan window (Figure 98). (Depending upon certain 
properties of the power source in your unit, the line may have a single peak, giving it the 
shape of a bell curve, or it may have more than one peak. See image below for a good 
example of the line spectrum.) 

Regardless of the particular shape of the curve, the peak of it should be between on half 
(½) and two thirds (2/3) of the B-scan window. 

6. To adjust the height of the curve, turn the (smaller) Reference Arm Power knob on the 
front of the engine (hardware), clockwise to raise the peak, or counterclockwise to lower 
the peak.  Note, there is a small tab that locks this knob.  When locked, the tab points 
down (5 o’clock position).  When unlocked, it is at the 4 o’clock position. 
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7. After adjusting the curve to the proper height, click the Stop Free Run button to end the 
scanning.  Relock the tab described in step 7 above. 

8. If you choose to save the line spectrum, click the Save Scan. 

9. From the Tools menu, select Load Settings..., and the Load Settings File dialog box 
opens. 

10. In the dialog box, select the appropriate User.INI file.  (If you are imaging the retina, load 
the retina User.INI file; if you are imaging the cornea, load the cornea User.INI file.)  The 
InVivoVue settings for scanning patients are restored and you may resume imaging 
patients. 

 

Figure 98: Process flow for checking the line spectrum 
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Creating a Line Spectrum Configuration File 

The line spectrum configuration file (LineSpectrum.INI) is used for loading the necessary system 
settings to check the (power) line spectrum of the InVivoVue hardware. If you want to check the 
line spectrum but find that you do not have the file LineSpectrum.INI, follow these steps to create 
the file. 

1. Select the Imaging tab. 

2. Select a scan and right click on the B-Scan Display and select the Display Options.  

3. At the top of the dialog box, click the Options tab. 

4. At the top of the Options tab, deselect the Custom check box. 

5. In the Display Type group box in the middle of the tab, select the Line option button. 

6. Close the Edit Options dialog box. 

7. From the Tools menu, select Configure Processing.  The Image Processing and 
Resampling Controls dialog box will open. 

8. At the top of the Processing tab, click the Clear All button, and close the dialog box. 

9. From the Tools menu, select Save Settings..., and the Save Settings File dialog box 
opens. 

10. At the bottom of the dialog box, in the File Name field type LineSpectrum, and click the 
Save button. The dialog box closes. 

If you just created this file for checking the line spectrum now, you can return to the topic, 
Checking the Line Spectrum. 
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Appendix I: Network Reader Setup 

Introduction 

Leica Envisu SDOIS users may require a network-based reader installation in which all data 
files are centrally available for viewing by multiple users. This configuration enables access to 
acquired data by one or many reader seats with access to a common network share folder.  

Background and Assumptions 

The Leica OCT reader database and associated image files will reside at a network storage 
location, enabling more than one Reader computer to access the exams (Figure 99). The 
Leica InVivoVue™ (IVV) software will reside on each Reader computer. If the acquisition 
system is connected to the local network, the data may be transferred over the network to a 
temporary storage location on the network (the “transfer drive”). In the absence of a network 
connection on the acquisition system, an external hard drive may be used to transfer the data.  

 

The import process copies the data from the transfer drive to the 
final network storage location. The data on the transfer drive may be 
used for archival purposes or deleted once the import into the 
network reader is complete.  

The network Reader configuration requires a dedicated drive letter to be mapped on each 
Reader computer to establish the path to the network storage location. The assigned network 
drive letter must be identical for every Reader computer. Drive letter “N” is used throughout 
this document, but another letter may be used. Consistency of this letter is critical for 
effective operation of the Network Reader configuration. 

Leica will provide reader software and all files required for use of the network reader 
configuration.  

 
Figure 99: Network Reader Workflow. 

Network Storage Location Setup 

1. Setup the drive path where image data will be stored at the network storage location. 

1.1. Working with your IT department, establish the top level folder where Leica exam 
data will be stored. For example:  \\{Network Path}\{Leica Reader Folder}\ 

1.1.1. {Network Path} is a path on your local network that is accessible by the 
Reader computers, e.g. \\mynetwork\subfolder1\.  
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1.1.2. {Leica Reader Folder} is the folder in which you would like to store the Leica 
Reader data, e.g. LeicaSDOIS.  

1.1.3. The final file path to the Leica data storage folder would then be: 
\\mynetwork\subfolder1\LeicaSDOIS.   

1.1. Create a folder “InVivoVue Reader” to create the path \\{Network Path}\{Leica 
Reader Folder}\InVivoVue Reader\. 

1.2. Add two folders “Bioptigen” and “Data” to create the path \\{Network 
Path}\{Bioptigen Reader Folder}\Bioptigen\Data\. 

 

Leica recommends allocating at least 2 TB of storage space. The size 
required will vary depending on the amount of data that needs to be 
accessed or archived on the network.  

 

No space characters can be used in the name of any folder in this 
network path.  

Reader Computer Setup 

1. Map the network storage location path on the Reader computer. 

1.1. Open a file window, and select Tools → Map Network Drive 

1.2. Select network drive “N:”and browse to the \\{Network Path}\{Leica Reader 
Folder}\ defined in Network Storage Location Setup.   

1.3. Select “OK” to identify the folder’s path. Select “Finish” to setup network drive. 

1.4. Select Start → Computer to confirm network drive path. 

 

You may have to logout and log back in to your computer to see the 
network path mapped to the correct drive letter. 

2. Install InVivoVue Software on the Reader computer(s) following the Reader installation 
procedure included with the InVivoVue installation media.  

3. Setup the InVivoVue network Reader database, Reader configuration file, and Reader 
software shortcut. 

3.1. Open a new explorer window and navigate to the network storage location at 
N:\InvivoVue Reader\.  

3.2. Leica Technical Support will provide a database file, user configuration file, and 
shortcut to be used by the network reader.  

3.3. Place the network reader database and user files, in the N:\InVivoVue Reader\ 
folder. 

3.4. Copy the “IVV Network Reader” shortcut on each Reader computer. 

 

The InVivoVue Network Reader must be accessed through the 
InVivoVue Network Reader shortcut. Running the InVivoVue 
Reader through the shortcut created during InVivoVue software 
installation will not provide access to the files stored on the network 
location. 

4. Test the network Reader setup.  
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4.1. Double click on the InVivoVue Network Reader shortcut.   

4.2. The  splash screen appears and the software opens in the Clinical Study tab. 

4.3. If no errors occur, then you are ready to Import exam data into the network storage 
location on N:\Bioptigen\Data. 

5. For additional computers, repeat the installation of InVivoVue and copy the network 
reader InVivoVue shortcut to each computer.  

Transfer Data to the Network Reader 

Leica OCT image data needs to be transferred from the acquisition system to a network folder 
to be viewed remotely by many readers across the network.    

Transfer Drive Setup 

1. Setup the following folders on the transfer drive, which can be either a network location 
or an external hard drive. The transfer drive letter can be any letter as assigned by the 
operating system, {Transfer Drive Letter}:\.  

1.1. Create a root folder on the transfer drive:  {Transfer Drive Letter}:\Bioptigen. 

1.2. Create a folder for storing exported exam files: {Transfer Drive 
Letter}:\Bioptigen\Exported Exams. 

1.3. Exams should then be exported from the OCT acquisition system to the transfer 
drive with each export requiring a unique folder in the Exported Exams parent 
folder, e.g. {Transfer Drive Letter}:\Bioptigen\Exported Exams\Export_1, 
{Transfer Drive Letter}:\Bioptigen\Exported Exams\Export_2. 

Export Exams from the Leica System 

The export process makes a copy of exam data to be stored on a separate location that can 
be imported by InVivoVue Readers. Exporting occurs on the exam level. Exporting creates a 
copy of the metadata and image files associated with the exam. 

 

Please see the software user manual for more information on the 
import and export features. 

Exporting Instructions 

1. On the SDOIS from InVivoVueClinic, select the Patient/Exam tab.  

2. Navigate to the Patient then select the specific exams you want to export. Click Export 
Exams button. 

3. Confirm that the “when exporting exams, make copies of the data files” box is checked.  

4. Check the “when exporting exam, include patient identifier” box if patient information 
other than the patient ID (e.g. first name and last name) should be available and visible 
on the Reader computers.   

5. Click Browse button next to “Export to” location. Create a new folder in {Transfer Drive 
Letter}:\Bioptigen\Exported Exams\ and name the folder as appropriate. 

6. Click OK on the Browse For Folder dialog box. 

7. Click Start Export.  
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8. Export metadata and image data are created in the named export folder.   

Import Exams from the Transfer Drive 

The import process copies exam data from the transfer drive used with the network Reader. 
Importing occurs on the exam level. Importing merges the export metadata into the Reader 
database and copies the image data files to the defined storage location.  

Importing Instructions 

1. On the Reader computer, open the IVV software then select Tools → Import Exam. 

2. Select the named export folder from the {Transfer Drive Letter}:\Bioptigen\Exported 
Exams folder. 

3. The import process is active until the image data has been copied to the storage 
location. The software will be unavailable for further action until the import has 
completed.  

 

The import process may take many minutes to complete depending 
on the speed of your network connection. Interrupting the import 
process by closing the software may result in a partial data import to 
the network location.  

Viewing Data from the Network Drive 

1. Open InVivoVue on the Reader computer.  

2. Select the Study tab and click the “Switch Sites” button. 

3. Select the “Choose Other Site” button and double-click the acquisition system site name. 

4. Select the Patient/Exam tab. Select the Patient, and the Patient Exams listed on the 
right will contain all the exams that have been imported. 

5. Double-clicking the specific exam will load the exam for review.  

6. Selecting a scan from the scan queue will load that file from the network and display it 
on the Reader computer.  

 

The rate at which data is loaded for viewing on a Reader depends on 
the speed of your network connection. Larger files may take longer to 
appear on the Reader accessing data on a network location.  
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Troubleshooting 

While this procedure is likely to work in most network environments, some situations may 
require additional support. Please review the troubleshooting tips below. If these do not rectify 
the problem, please contact Leica Customer Support).  Network issues may require a meeting 
with your IT department to solve the problem.  

 

Problem Solution 

Shortcut does not work.  Please confirm the network path is correct and mapped to the 
drive letter defined at setup, e.g. N:\.  

Database not found. Please confirm the network path is correct and the database 
copied to the proper folder. 

Data Path not found You may receive an error window stating “Configured save path 
does not exist.  Please select a valid save path.”  If this is the 
case, then the drive letter and/or folder structure may not be 
correct. 

 

 

 

If the Data Path is not found when starting the Reader software, do 
not choose another location. The network path or configuration file 
must be corrected in order for the Network Reader to function 
properly. 



InVivoVue (Release 2.4) 

Page 114 of 120  9054-10054 Rev E 

Appendix II: InVivoVue 2.4 Software Installation and 
Upgrade Instructions 

Purpose 

Instructions on installing InVivoVue 2.4 or upgrading from InVivoVue 2.x to InVivoVue 2.4. 
Note this does not include upgrading from versions prior to IVV 2.0. For upgrading from 
versions prior to 2.0, please contact the Leica Customer Service department. 

Materials Needed 

1. The Leica InVivoVue 2.2 USB memory stick. 

Installing InVivoVue Reader for the First Time 

This section describes the process to install the InVivoVue Reader software on a computer for 
the first time. To upgrade an existing installation, see section Upgrading InVivoVue Software 
from version 2.x to 2.4. 

 

1. Data Management 

a) InVivoVue2.4 Reader is configured to use 

C:\ProgramData\Bioptigen\InVivoVue\Data  as the reader data storage path by 

default. 

b) Sample data that is approximately 3.5 GB in size will be installed to the data storage 

path by default.  

c) As InVivoVue creates a copy of all imported data in the data storage path, this 

configuration can cause the C: drive to fill quickly if many exams are imported.  

d) Please contact Leica Customer Support for alternate configurations, such as utilizing 

an external hard drive to store image data. 

 

2. Installation Procedure 

a) Insert the Leica USB into a USB port on the reader computer.  

b) On the USB, open the folder “InVivoVue\Software”. 

c) Run “setup.exe” from the USB.  

file:///C:/ProgramData/Bioptigen/InVivoVue/Data
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d) In the welcome window, press Next.  

 
 

e) When asked if you want to install Acquisition or Reader only, select Reader only. 

 
 

f) After the installation is completed, eject the USB memory stick and remove it from 

the port. 

g) Start the application by double-clicking on the InVivoVue Reader shortcut on the 

desktop. If any warnings or problems arise, please contact Leica Customer Support. 

 

3. Using the InVivoVue Reader Software 

a) In order to work with image data from existing exams, you will have to Export 

existing exams from the OCT system and then Import them to the computer with 

InVivoVue Reader.  

b) Export may include saving the data to an external hard drive or network drive. The 

InVivoVue Reader can import from either location.  

c) Please review “Exporting Exams” in the Software User Manual. 

d) Please review “Importing Exams” in the Software User Manual. 

e) You will need to “Switch Sites” in order to view the exams. This is described in 

“Reading Non-Native Site Data” in the Software User Manual. 
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Upgrading InVivoVue Software from version 2.x to 2.4 

This section describes the process to upgrade an existing installation of the InVivoVue 
software (2.x and up). This will guide you through upgrading either an Acquisition System or a 
Reader installation. 

 

This process will uninstall the previous version of InVivoVue, and then install the new version. 
When InVivoVue is uninstalled, no configuration data or image data will be affected. Only the 
program files will be removed. 

 

1. Uninstalling InVivoVue versions 2.0 or 2.1 

If you are upgrading from version 2.2 or later, you do not need to uninstall. However, 

versions 2.0 or 2.1 must be uninstalled before upgrading to InVivoVue 2.4. 

 

a) Select the Window’s Start button, and then select Control Panel. 

b) Select either Programs and Features or Uninstall a program (depending on the 

layout of the Control Panel). 

c) If the program Basler cIBBProtocol Library is present, select the program and click 

Uninstall. Allow the program to finish uninstalling and navigate back to the 

Programs and Features or Uninstall a program section of the Control Panel. If it 

is not present, continue with step d.     

d) Select Bioptigen InVivoVue from the list of programs. 

e) Press the Uninstall button at the top of the list. 

f) Follow the on-screen instructions to uninstall InVivoVue. 

 

2. Installing the New Version of InVivoVue Software 

a) Insert the Leica USB into a USB port on the computer.  

b) On the USB, open the folder “InVivoVue\Software”. 

c) Run “setup.exe” from the USB.  
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d) In the welcome window, press Next.  

 
 

e) If an Envisu acquisition system is being upgraded, select Acquisition. 

If an InVivoVue Reader installation is being upgraded, select Reader only. 

 
 

f) Press Next and follow the on-screen instructions. 

g) After the installation is completed, eject the USB memory stick and remove it from 

the port. 

h) Start the application by double-clicking on an InVivoVue shortcut on the desktop. If 

any warnings or problems arise, please contact Leica Customer Support. 

For Envisu 
acquisition 

system 

For 
InVivoVue 

Reader 
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